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Legal disclaimer
Alibaba Cloud reminds you to carefully read and fully understand the terms and 
conditions of this legal disclaimer before you read or use this document. If you have 
read or used this document, it shall be deemed as your total acceptance of this legal 
disclaimer.
1. You shall download and obtain this document from the Alibaba Cloud website

 or other Alibaba Cloud-authorized channels, and use this document for your 
own legal business activities only. The content of this document is considered
 confidential information of Alibaba Cloud. You shall strictly abide by the 
confidentiality obligations. No part of this document shall be disclosed or provided
 to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted, 
or disseminated by any organization, company, or individual in any form or by any 
means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify 
the content of this document without notice and the updated versions of this
 document will be occasionally released through Alibaba Cloud-authorized 
channels. You shall pay attention to the version changes of this document as they 
occur and download and obtain the most up-to-date version of this document from 
Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud 
products and services. Alibaba Cloud provides the document in the context that
 Alibaba Cloud products and services are provided on an "as is", "with all faults
" and "as available" basis. Alibaba Cloud makes every effort to provide relevant
 operational guidance based on existing technologies. However, Alibaba Cloud 
hereby makes a clear statement that it in no way guarantees the accuracy, integrity
, applicability, and reliability of the content of this document, either explicitly 
or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial
 losses incurred by any organizations, companies, or individuals arising from 
their download, use, or trust in this document. Alibaba Cloud shall not, under any
 circumstances, bear responsibility for any indirect, consequential, exemplary, 
incidental, special, or punitive damages, including lost profits arising from the use
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 or trust in this document, even if Alibaba Cloud has been notified of the possibility
 of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to 
works, products, images, archives, information, materials, website architecture, 
website graphic layout, and webpage design, are intellectual property of Alibaba
 Cloud and/or its affiliates. This intellectual property includes, but is not limited
 to, trademark rights, patent rights, copyrights, and trade secrets. No part of the
 Alibaba Cloud website, product programs, or content shall be used, modified
, reproduced, publicly transmitted, changed, disseminated, distributed, or 
published without the prior written consent of Alibaba Cloud and/or its affiliates
. The names owned by Alibaba Cloud shall not be used, published, or reproduced 
for marketing, advertising, promotion, or other purposes without the prior written
 consent of Alibaba Cloud. The names owned by Alibaba Cloud include, but are 
not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba 
Cloud and/or its affiliates, which appear separately or in combination, as well as
 the auxiliary signs and patterns of the preceding brands, or anything similar to 
the company names, trade names, trademarks, product or service names, domain
 names, patterns, logos, marks, signs, or special descriptions that third parties 
identify as Alibaba Cloud and/or its affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions
Table -1: Style conventions
Style Description Example

This warning information 
indicates a situation that will 
cause major system changes, 
faults, physical injuries, and other
 adverse results.

Danger:
Resetting will result in the loss of
user configuration data.

This warning information 
indicates a situation that may 
cause major system changes, 
faults, physical injuries, and other
 adverse results.

Warning:
Restarting will cause business
interruption. About 10 minutes are
required to restore business.

This indicates warning informatio
n, supplementary instructions, 
and other content that the user 
must understand.

Notice:
Take the necessary precautions
to save exported data containing
sensitive information.

This indicates supplemental 
instructions, best practices, tips, 
and other content that is good to 
know for the user.

Note:
You can use Ctrl + A to select all
files.

> Multi-level menu cascade. Settings > Network > Set network
type

Bold It is used for buttons, menus
, page names, and other UI 
elements.

Click OK.

Courier
 font

It is used for commands. Run the cd  / d  C :/ windows
 command to enter the Windows

system folder.
Italics It is used for parameters and 

variables.
bae  log  list  --
instanceid  Instance_ID

[] or [a|b] It indicates that it is a optional 
value, and only one item can be 
selected.

ipconfig  [-all|-t]
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Style Description Example
{} or {a|b} It indicates that it is a required 

value, and only one item can be 
selected.

swich  {stand | slave}
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1 Image overview
This topic provides an overview of the different types of ECS images provided by
Alibaba Cloud, including their types and lifecycle. It also describes the common
image operations. An image works as a file copy that includes all the data from the
system disk or from the system disk and data disks of an ECS instance.

Type of images
ECS images are classified into public images, custom images, shared images, and
Marketplace images. We recommend that you maintain a sufficient balance in the
linked credit card or PayPal account to complete the payment or preauthorization.
For more information, see Pricing overview.
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Image type Description Is payment required?
Public image Public images are fully

licensed images that are
provided by Alibaba Cloud
to ensure a stable, secure
operating environment.
They can run in all Windows
Server and leading Linux
operating systems. For more
information, see Public
images.

Only public images that run in
the Red Hat Enterprise Linux
and Windows Server operating
systems are charged fees because
they are licensed by Red Hat and
Microsoft, respectively. All other
public images are provided free of
charge. The details of the fee for Red
Hat Enterprise Linux and Windows
Server public images are as follows:
• Red Hat Enterprise Linux: Fees 

vary depending on the instance 
type.

• Windows Server: If the public 
image is used in ECS instances in
 regions of Mainland China, the 
public image is provided free of 
charge. If the public image is used
 in ECS instances in other regions, 
a fee is charged.

The public images that run in other
 operating systems than Windows 
Server and Red Hat Enterprise Linux 
are provided free of charge.

Custom image Custom images are created
from ECS instances or
snapshots, or imported from
your computer. A custom
image can be used, shared,
copied, and deleted only by
the user who created it. For
more information, see Life
cycle of a custom image.

The account under which a custom
 image is created is charged a fee 
when the custom image is referenced
 as a Marketplace image.
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Image type Description Is payment required?
Shared image Images can be shared among

Alibaba Cloud accounts. For
more information, see Share
images.

When you use a shared Marketplac
e image, you are charged a fee 
according to the billing method 
specified by the ISV in the Alibaba 
Cloud Marketplace.

Marketplace 
image Marketplace images are

categorized into the following
two types:
• Marketplace images that

 are provided by Alibaba 
Cloud

• Marketplace images 
that are provided by 
independent software
 vendors (ISVs) upon
 authorization of the 
Alibaba Cloud Marketplace

A Marketplace image
contains an operating system
and pre-installed software.
The operating system and
pre-installed software have
been tested and verified by
Alibaba Cloud to ensure that
the image content is secure.
For more information, see
Marketplace images.

A Marketplace image is charged 
according to the billing method 
specified by the specific ISV in the 
Cloud Marketplace.

Lifecycle of a custom image
After you create or import a custom image, this image is the Available  state. You
can use this image to create an ECS instance, share it with another Alibaba Cloud
account, copy it to another region, or delete it when you no longer need it. The
following figure shows the lifecycle of a custom image.
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Create a custom image
After you create an ECS instance by using an existing custom image, you can
configure the instance as needed. For example, you can install software and deploy
projects in the instance. Additionally, you can create a custom image for the instance.
For more information, see Create a custom image by using an instance.

Note:
An ECS instance that is created by using this custom image contains all the
configuration items that you have defined. For more information, see Create an
instance by using a custom image.

You can create a custom image by using a system disk or by using a system disk and
data disks. For more information, see Create a custom image by using a snapshot.
You can also import a custom image from your computer. For more information, see
Import custom images.

Share and copy a custom image
Each image belongs to a region. For example, if you create a custom image in China 
North 2 (Beijing), you can use this image to create an ECS instance only in the region.
• You can only share the image with a user who is located in the same region. To

share the image with a user who is located in a different region, you need to copy
the image to the region first. For more information, see Share images.
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• If you want to use this image in a different region, you need to copy this image
to the region. The image copy is independent and has a unique ID. For more
information, see Copy images.

Change the image for an ECS instance
After you create an ECS instance, you can change its image by replacing its system
disk.
• If you want to change the image to a public image, see Replace the system disk by

using a public image.
• If you want to change the image to a custom, Marketplace, or shared image, see

Replace the system disk (non-public image).
Delete a custom image

You can delete a custom image when you no longer need it. After you delete a custom
image, you cannot create an ECS instance by using this image or reinitialize the cloud
disk for an ECS instance created by using this image. For more information, see
Reinitialize a cloud disk.
A custom image consists of the disks of an ECS instance. After you delete a custom
image, the snapshots in it are not deleted. If you no longer need the snapshots, you
can delete them from the snapshot list. For more information, see Delete custom
images.

APIs
You can call ECS API actions to operate images. For more information, see API
overview.
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2 Select an image
This topic describes how to select an appropriate image for your instance.
We recommend that you take the following items into consideration when selecting
an image for your instance:
• Region
• Image type and billing method
• Operating system
• Built-in software (such as MySQL and other applications)

Region
Images are regional resources. An image that is used to create instances must belong
to the same region as the instances. For example, if you create an instance in China
North 2, you can use images only in China North 2. For more information, see Regions
and zones.
To create an instance by using an image located in a different region, you must first
copy the image to the current region. For more information, see Copy images.

Image types and billing methods
ECS images are classified into public images, custom images, shared images, and
Marketplace images, according to the image source. For information about image
types and billing methods, see Image overview.

Operating system
You must select an operating system (OS) during instance creation.
• OS architecture

You can select a 32-bit or 64-bit OS architecture for your instance.
- 32-bit OS architecture supports a maximum of 4 GiB memory. Additionally, a 32-

bit Windows OS supports a maximum of four CPU cores.
- 64-bit OS architecture supports at least 4 GiB memory and larger.
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• OS type (Windows or Linux/Unix-like OS)
OS type Logon mode Feature Scenario
Windows Remote 

Desktop 
Connection

A Windows public 
image is installed with
 a genuine activated 
system.

- Supporting programs
 developed based on 
Windows, such as .NET

- Supporting SQL Server 
and other databases (you 
need to manually install a
 database first.)

Linux/Unix
-like

SSH A common server
-side open-source
 operating system 
that features high 
security and stability
, fast deployment, 
and easy source code 
compilation.

- Generally used for server 
applications such as high-
performance web servers

- Supporting common 
programming languages 
such as PHP and Python

- Supporting MySQL and
 other databases (you 
need to manually install a
 database first.)

Alibaba Cloud provides a list of public images that run Windows or Linux/Unix-like
OS. For more information, see Overview of public images.

• Considerations for Windows
The following information is provided for your consideration if you select to run 
Windows on your instance. Generally, we recommend that you use a later version 
of Windows for ease of use and better security.
- Instance types with one vCPU core and 1 GiB memory cannot start the MySQL 

database.
- We recommend that your target instances have at least 2 GiB memory or 

larger if you want to host one or more websites, deploy web environments, or
 use Windows Server 2008, Windows Server 2012, Windows Server 2016, or 
Windows Server 2019. Otherwise, the selected image may not be displayed on 
the purchase page, instance performance may be degraded, or both.

- Alibaba Cloud no longer provides technical support for Windows Server 2003
system images. For more information, see Offline announcement of Windows 
Server 2003 system image.
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• Considerations for Linux and Unix-like OSs
The following information is provided for your consideration if you run a Linux or
 Unix-like operating system on your instance, and includes detailed information 
about the supported image versions.
- Aliyun Linux

Aliyun Linux is an operating system developed by Alibaba Cloud that provides a
safer, more stable, and high-performance running environment for applications
on ECS instances. Aliyun Linux 2 supports various cloud scenarios and
instance types (except for instances in a classic network and non-I/O-optimized
instances). For more information, see Aliyun Linux 2.

- Red Hat series
■ CentOS
■ Red Hat
The following table compares CentOS with Red Hat.
OS Software

 package 
format

Package 
manager

Billing method Feature Relationsh
ip

CentOS .rpm yum Free usage ■ Stable
, but 
lower 
patch 
update
 speed
 than
 Red 
Hat

■ Supporting
 online
 
instant
 
upgrades

■ CentOS
 is an 
open-
source 
version
 of Red 
Hat.

■ They can
 use the
 same
 RPM 
package
 and 
commands
.
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OS Software
 package 
format

Package 
manager

Billing method Feature Relationsh
ip

Red 
Hat

Paid usage Stable
 with 
enterprise
-level 
technical
 support

- Debian series
■ Debian
■ Ubuntu
The following table compares Debian with Ubuntu.
OS Software package

 format
Package manager Feature Relationship

Debian aptitude Stable
Ubuntu

.deb
apt-get ■ User-

friendly
 system 
configurat
ion

■ Timely 
software 
updates

■ Easy to use

Ubuntu 
builds on 
the Debian 
architecture 
and infrastruc
ture.

- SUSE
■ SUSE Linux
■ openSUSE
The following table compares SUSE Linux with openSUSE.
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OS Feature Relationship
openSUSE
SUSE Linux

■ openSUSE is the community
 version of SUSE Linux. It 
features advanced software 
versions, better extensibility
(desktop and server installati
on are supported), and 
free updates (you can also 
purchase official technical 
support).

■ SUSE Linux Enterprise is the
 enterprise version of SUSE 
Linux. It is more mature and 
stable, but its official release
 contains fewer software 
features than openSUSE.

■ SUSE Linux Enterprise offers
 better work and production
 environments, whereas 
openSUSE delivers a superior
 entertainment experience 
and professional services.

■ As of version 10.2, SUSE 
Linux was officially renamed
 openSUSE.

■ openSUSE uses the same 
kernel as SUSE Linux.

- CoreOS
CoreOS is an open-source lightweight operating system based on the Linux 
kernel and designed to provide infrastructure for clustered deployments. It 
focuses on automation, ease of application deployment, security, reliability, and
 scalability. CoreOS provides the underlying functionality required for deploying
 applications inside software containers, together with a set of built-in tools for 
service discovery and configuration sharing.

- FreeBSD
FreeBSD is a Unix-like operating system for a variety of platforms which
focuses on features, speed, and stability. FreeBSD offers advanced networking,
performance, security and compatibility features today which are still missing
in other operating systems, even some of the best commercial ones. For more
information, see FreeBSD official documentation.
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Built-in software
Alibaba Cloud Marketplace images are typically provided pre-installed with a running
environment and software applications that you can apply to target ECS instances as
needed. For more information, see Marketplace images.

What to do next
• Use a target image to create instances. For more information, see Create an

instance by using the wizard.
• Use a target image to change the operating system of a current image. For more

information, see Change the operating system.
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3 Search for an image
This topic describes how to search for a specific image through the ECS console or by
calling the related API action.

Use the ECS console
You can search for a specific image on the Images page of the ECS console.
Procedure
1. Log on to the ECS console.
2. In the left-side navigation pane, choose Instances & Images > Custom Images.
3. Click the tab of a specific image type.
4. In the drop-down list, select a search item such as image name, image ID, or 

snapshot ID.
5. Enter one or more keywords in the search bar.

For an ID search, you must enter an exact keyword item. For an image name
search, you can enter partial keyword items (such as win  to return Windows
public image results).

6. Click Search.
Call an API action

You can call DescribeImages to search for an image through the API Explorer or 
Alibaba Cloud CLI. The following procedure uses the API Explorer as an example.
1. Log on to the API Explorer.
2. In the drop-down list of RegionId, select the target region.
3. Optional. Specify other parameters, such as ImageName and ImageId.

Note:
The naming rules of image IDs are as follows:
• Public image: The image ID is named by the version, architecture, language,

and release date of the operating system. For example, the image ID of a 64-bit
Windows Server 2008 R2 Enterprise Edition (English version) is win2008r2_

64_ent_sp1 _en - us_40G_ali base_20190 318 . vhd .
• Custom image and Marketplace image: The image ID starts with an m .
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• Shared image: The image ID is the same as the ID of the source custom image.
4. Click Submit Request.
5. Click the Debugging Result tab.

If the required image is found, detailed information of the image, such as the
image ID, image description, and operating system type is displayed on the
Debugging Result tab. For more information, see DescribeInstances.

What to do next
After you find the required image, you can:
• Create an instance by using the wizard.
• Share images.
• Copy custom images.
• #unique_26.
• Delete custom images.
• Modify custom images.
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4 Public image
4.1 Public images

This topic describes the public images provided by Alibaba Cloud. Alibaba Cloud
provides Aliyun Linux, a customized public image type that is natively supported
by ECS, in addition to public images that are authorized by corresponding third-
party vendors and have been tested by Alibaba Cloud to provide a secure and stable
operating environment for applications in ECS instances. All users can create ECS
instances using public images (except for the Windows Server and Red Hat Enterprise
Linux images) for free.

Types of public images
Alibaba Cloud provides two types of public images.
Type Description Technical support
Aliyun Linux 
images

The Aliyun Linux images are custom
, native operating systems provided
 by Alibaba Cloud for ECS. Each 
Aliyun Linux image has undergone
 stringent testing to guarantee its
 security, stability, and normal 
startup and operation.

Alibaba Cloud provides
technical support. To
access support, open a 
ticket.

Third-party and
 open source 
images

These images have undergone
stringent testing conducted by
Alibaba Cloud to guarantee their
security, stability, and normal
startup and operation. Such images
include:
• Windows: Windows Server
• Linux: Ubuntu, CentOS, Redhat 

Enterprise Linux, Debian, SUSE 
Linux, FreeBSD, and CoreOS

We recommend that you 
contact the corresponding 
OS vendors or open source
 communities for technical
 support. In addition, 
Alibaba Cloud provides 
technical support to assist
 with investigation into 
various image-related and 
system-related problems.

Aliyun Linux images
Aliyun Linux is a Linux public image independently developed by Alibaba Cloud. The
following table describes the available versions of Aliyun Linux.

14 Issue: 20190718

https://selfservice.console.aliyun.com/ticket/createIndex.htm
https://selfservice.console.aliyun.com/ticket/createIndex.htm


Elastic Compute Service Images /  4 Public image

Operating 
system

Version Description

Aliyun Linux 2 Aliyun Linux 2.
1903 64-bit A next-generation OS that supports more 

Alibaba Cloud instance types (including ECS 
Bare Metal Instances) than the previous Aliyun
 Linux image. Aliyun Linux 2 is also equipped
 with Alibaba Cloud command line tools and 
other software packages by default.
If you are replacing other Linux distributions
 with Aliyun Linux, we recommend that you 
switch to Aliyun Linux 2. If you are currently 
using the Aliyun Linux image, we recommend
 that you replace the current distribution with
 Aliyun Linux 2 by creating a new instance or 
replacing the system disk.
For more information, see Aliyun Linux 2.

Aliyun Linux Aliyun Linux 17.1
 64-bit

A secure, stable, and high-performance Linux
image that interoperates natively with Alibaba
Cloud ECS. For more information, see Aliyun
Linux 17.1.

Third-party and open source images
Alibaba Cloud regularly releases or updates the public images of third-party and open
source vendors. For more information, see Image release records. You can also view
all available public images on the public images page in the corresponding region in
the ECS console.
The following tables provide references regarding the current third-party and open
source image versions provided by Alibaba Cloud (Windows and Linux).
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• Windows images
Operating system Version
Windows Server 2019 - Windows Server 2019 data center 64-bit (Chinese 

edition)
- Windows Server 2019 data center 64-bit (English 

edition)
Windows Server 2016 - Windows Server 2016 data center 64-bit (Chinese 

edition)
- Windows Server 2016 data center 64-bit (English 

edition)
Windows Server 2012 - Windows Server 2012 R2 data center 64-bit (

Chinese edition)
- Windows Server 2012 R2 data center 64-bit (English

 edition)
Windows Server 2008 - Windows Server 2008 standard SP2 32-bit (Chinese

 edition)
- Windows Server 2008 R2 enterprise 64-bit (Chinese

 edition)
- Windows Server 2008 R2 enterprise 64-bit (English

 edition)
Note:

If you are using a 32-bit operating system, select an
instance type with a memory capacity that does not
exceed 4 GiB. For more information, see Select an
image.

Windows Server Version 
1809 - Windows Server Version 1809 data center 64-bit (

Chinese edition)
- Windows Server Version 1809 data center 64-bit (

English edition)
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• Linux images
Operating system Version
CentOS - CentOS 7.6 64-bit

- CentOS 7.5 64-bit
- CentOS 7.4 64-bit
- CentOS 7.3 64-bit
- CentOS 7.2 64-bit
- CentOS 6.10 64-bit
- CentOS 6.9 64-bit
- CentOS 6.8 32-bit

Note:
If you are using a 32-bit operating system, select an
instance type with a memory capacity that does not
exceed 4 GiB. For more information, see Select an
image.

CoreOS - CoreOS 2023.4.0 64-bit
- CoreOS 1745.7.0 64-bit

Debian - Debian 9.8 64-bit
- Debian 9.6 64-bit
- Debian 8.11 64-bit
- Debian 8.9 64-bit

FreeBSD FreeBSD 11.1 64-bit
OpenSUSE OpenSUSE 42.3 64-bit
Red Hat - Red Hat Enterprise Linux 7.5 64-bit

- Red Hat Enterprise Linux 7.4 64-bit
- Red Hat Enterprise Linux 6.9 64-bit

SUSE Linux - SUSE Linux Enterprise Server 12 SP2 64-bit
- SUSE Linux Enterprise Server 11 SP4 64-bit
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Operating system Version
Ubuntu - Ubuntu 18.04 64-bit

- Ubuntu 16.04 64-bit
- Ubuntu 16.04 32-bit
- Ubuntu 14.04 64-bit
- Ubuntu 14.04 32-bit

Note:
If you are using a 32-bit operating system, select an
instance type with a memory capacity that does not
exceed 4 GiB. For more information, see Select an
image.

4.2 Release notes
This topic describes the release notes of images and relevant updates.

May 28, 2019
Release Description
Windows Server 2019 
Datacenter Edition • Image ID:

- win2019_64_dtc_1809_zh-cn_40G_alibase_20190
528.vhd (Chinese edition)

- win2019_64_dtc_1809_en-us_40G_alibase_20190
528.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
Windows Server Version 
1809 Datacenter Edition • Image ID:

- winsvr_64_dtcC_1809_zh-cn_40G_alibase_20190
528.vhd (Chinese edition)

- winsvr_64_dtcC_1809_en-us_40G_alibase_20190
528.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches

18 Issue: 20190718



Elastic Compute Service Images /  4 Public image

May 23, 2019
Release Description
Windows Server 2016 
Datacenter Edition • Image ID:

- win2016_64_dtc_1607_zh-cn_40G_alibase_20190
523.vhd (Chinese edition)

- win2016_64_dtc_1607_en-us_40G_alibase_20190
523.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
Windows Server 2012 R2 
Datacenter Edition • Image ID:

- win2012r2_64_dtc_9600_zh-cn_40G_alibase_20190
523.vhd (Chinese edition)

- win2012r2_64_dtc_9600_en-us_40G_alibase_20190
523.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
May 17, 2019

Release Description
Windows Server 2008 
Standard Edition SP2 • Image ID: win2008_32_std_sp2_zh-cn_40G_ali

base_20190517.vhd (Chinese edition)
• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Fixed a remote code execution vulnerability (CVE-

2019-0708) in Microsoft Windows Remote Desktop
 Services
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May 15, 2019
Release Description
Windows Server 2008 R2 
Enterprise Edition • Image ID:

- win2008r2_64_ent_sp1_zh-cn_40G_alibase_20190
515.vhd (Chinese edition)

- win2008r2_64_ent_sp1_en-us_40G_alibase_20190
515.vhd (English edition)

• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Fixed a remote code execution vulnerability (CVE-

2019-0708) in Microsoft Windows Remote Desktop
 Services

May 13, 2019
Release Description
Ubuntu 16.04 • Image ID: ubuntu_16_04_64_20G_alibase_20190513.

vhd
• Kernel version: 4.4.0-146-generic
• Released in: all regions
• Changes: updated to the latest operating system 

patches
May 10, 2019

Release Description
Debian 9.9 • Image ID: debian_9_09_64_20G_alibase_20190510.

vhd
• Kernel version: 4.9.0-9-amd64
• Released in: all regions
• Changes: updated to the latest operating system 

patches
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May 9, 2019
Release Description
Ubuntu 18.04 • Image ID: ubuntu_18_04_64_20G_alibase_20190509.

vhd
• Kernel version: 4.15.0-48-generic
• Released in: all regions
• Changes:

- Updated cloud-init to speed up boot time
- Updated to the latest operating system patches

May 7, 2019
Release Description
Aliyun Linux 2 • Image ID: aliyun-2.1903-x64-20G-alibase-20190507

.vhd
• Kernel version: 4.19.34-11.al7.x86_64
• Released in: all regions
• Changes:

- Updated the system kernel and user mode 
package

- Fixed the time synchronization latency at 
instance startup

March 27, 2019
Release Description
Aliyun Linux 2 • Image ID: aliyun-2.1903-x64-20G-alibase-20190327

.vhd
• Kernel version: 4.19.24-9.al7.x86_64
• Released in: all regions
• Changes: released Aliyun Linux 2
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March 19, 2019
Release Description
CoreOS 2023.4.0 • Image ID: coreos_2023_4_0_64_30G_alibase_20190319.

vhd
• Kernel version: 4.19.25-coreos
• Released in: all regions
• Changes: updated to the latest operating system patches

March 18, 2019
Release Description
Windows Server 2019 
Datacenter Edition • Image ID:

- win2019_64_dtc_1809_zh-cn_40G_ali
base_20190318.vhd (Chinese edition)

- win2019_64_dtc_1809_en-us_40G_ali
base_20190318.vhd (English edition)

• Released in: all regions
• Changes: new release

Windows Server 2016 
Datacenter Edition • Image ID:

- win2016_64_dtc_1607_zh-cn_40G_ali
base_20190318.vhd (Chinese edition)

- win2016_64_dtc_1607_en-us_40G_ali
base_20190318.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
Windows Server 2012 R2 
Datacenter Edition • Image ID:

- win2012r2_64_dtc_9600_zh-cn_40G_ali
base_20190318.vhd (Chinese edition)

- win2012r2_64_dtc_9600_en-us_40G_ali
base_20190318.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
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Release Description
Windows Server 2008 R2 
Enterprise Edition • Image ID:

- win2008r2_64_ent_sp1_zh-cn_40G_ali
base_20190318.vhd (Chinese edition)

- win2008r2_64_ent_sp1_en-us_40G_ali
base_20190318.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
Windows Server Version 1809
 Datacenter Edition • Image ID:

- winsvr_64_dtcC_1809_zh-cn_40G_ali
base_20190318.vhd (Chinese edition)

- winsvr_64_dtcC_1809_en-us_40G_ali
base_20190318.vhd (English edition)

• Released in: all regions
• Changes: updated to the latest operating system 

patches
March 11, 2019

Release Description
Debian 8.11 • Image ID: debian_8.11_64_20G_alibase_20190311.vhd

• Kernel version: 3.16.0-7-amd64
• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Fixed invalid apt source configurations in Debian 8.9

March 1, 2019
Release Description
Ubuntu 16.04 • Image ID: ubuntu_16_04_64_20G_alibase_20190301.vhd

• Kernel version: 4.4.0-142-generic
• Released in: all regions
• Changes: updated to the latest operating system patches
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February 25, 2019
Release Description
Debian 9.8 • Image ID: debian_9_08_64_20G_alibase_20190225.vhd

• Kernel version: 4.9.0-8-amd64
• Released in: China North 2, China North 3, and China 

North 5
• Changes: updated to the latest operating system patches

February 23, 2019
Release Description
Ubuntu 18.04 • Image ID: ubuntu_18_04_64_20G_alibase_20190223.vhd

• Kernel version: 4.15.0-45-generic
• Released in: all regions
• Changes: updated to the latest operating system patches

February 18, 2019
Release Description
CentOS 7.6 • Image ID: centos_7_06_64_20G_alibase_20190218.vhd

• Kernel version: 3.10.0-957.5.1.el7.x86_64
• Released in: all regions
• Changes: updated to the latest operating system patches

January 3, 2019
Release Description
Debian9.6 • Image ID: debian_9_06_64_20G_alibase_20190103.vhd

• Kernel version: 4.9.0-8-amd64
• Released in: all regions
• Changes: enabled the systemd-networkd service
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December 22, 2018
Release Description
Windows Server
 version 1809 
Datacenter Edition

• Image ID:
- winsvr_64_dtcC_1809_zh-cn_40G_alibase_20181222.

vhd (Chinese version)
- winsvr_64_dtcC_1809_en-us_40G_alibase_20181222.

vhd (English version)
• Released in: all regions
• Changes:

- Updated the image to the latest patch KB4483235 (
released in December 2018)

- Used the Sysprep tool to generalize the image
Windows Server 2008 
R2 Enterprise Edition • Image ID: win2008r2_64_ent_sp1_en-us_40G_ali

base_20181222.vhd (English version)
• Released in: all regions
• Changes:

- Updated the image to the latest patch KB3371318 (
released in December 2018). As a result, Windows 
clients need to be updated with the latest patches to 
establish RDP connections.

- Upgraded NET Framework to 4.7.2
- Used the Sysprep tool to generalize the image

December 20, 2018
Release Description
Windows Server 2008 
R2 Enterprise Edition • Image ID: win2008r2_64_ent_sp1_zh-cn_40G_ali

base_20181220.vhd (Chinese version)
• Released in: all regions
• Changes:

- Updated the image to the latest patch KB4471318 (
released in December 2018). As a result, Windows 
clients need to be updated with the latest patches to 
establish RDP connections.

- Upgraded NET Framework to 4.7.2
- Used the Sysprep tool to generalize the image
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Release Description
Windows Server 2012 
R2 Datacenter Edition • Image ID:

- win2012r2_64_dtc_9600_zh-cn_40G_alibase_20181220
.vhd (Chinese version)

- win2012r2_64_dtc_9600_en-us_40G_alibase_20181220.
vhd (English version)

• Released in: all regions
• Changes:

- Updated the image to the latest patch KB4471320 (
released in December 2018). As a result, Windows 
clients need to be updated with the latest patches to 
establish RDP connections.

- Upgraded NET Framework to 4.7.2
- Used the Sysprep tool to generalize the image

Windows Server 2016 
Datacenter Edition • Image ID:

- win2016_64_dtc_1607_zh-cn_40G_alibase_20181220.
vhd (Chinese version)

- win2016_64_dtc_1607_en-us_40G_alibase_20181220.
vhd (English version)

• Released in: all regions
• Changes:

- Updated the image to the latest patch KB4471321 (
released in December 2018). As a result, Windows 
clients need to be updated with the latest patches to 
establish RDP connections.

- Upgraded NET Framework to 4.7.2
- Used the Sysprep tool to generalize the image

December 12, 2018
Release Description
CentOS 7.6 • Image ID: centos_7_05_64_20G_alibase_20181212.vhd

• Kernel version: 3.10.0-957.1.3.el7.x86_64
• Released in: all regions
• Changes: updated to the latest operating system patches
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Release Description
Debian 9.6 • Image ID: debian_9_06_64_20G_alibase_20181212.vhd

• Kernel version: 4.9.0-8-amd64
• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Updated the cloud-init version
- Enabled the chrony service (time synchronization)
- Set GRUB_TIMEOUT=1

• Known issues: Classic network configuration issues
Ubuntu 18.04 • Image ID: ubuntu_18_04_64_20G_alibase_20181212.vhd

• Kernel version: 4.15.0-42-generic
• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Updated the cloud-init version
- Enabled the chrony service (time synchronization)
- Set GRUB_TIMEOUT=1

December 10, 2018
Release Description
CentOS 7.5 • Image ID: centos_7_05_64_20G_alibase_20181210.vhd

• Kernel version: 3.10.0-862.3.3.el7.x86_64
• Released in: all regions
• Changes:

- Updated to the latest operating system patches
- Updated the cloud-init version
- Enabled the chrony service (time synchronization)
- Disabled password logon by default
- Set GRUB_TIMEOUT=1

4.3 Aliyun Linux 2
Aliyun Linux 2 is a next-generation Aliyun Linux operating system developed by
Alibaba Cloud. It is intended to provide a safer, more stable, and high-performance
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running environment for applications on ECS instances. You can create an instance
by using the Aliyun Linux 2 public image for free.

Scope of application
• Various workloads on cloud. For example, you can run databases, data analytics

, Web applications, and other workloads in a production environment on Aliyun 
Linux 2.

• Various instance type families, including ECS Bare Metal Instances. The supported
instance specifications are as follows:
- vCPU: 1 vCPU - 160 vCPU
- Memory: 0.5 GiB - 3,840 GiB

Note:
Aliyun Linux 2 does not support instances that use the Xen virtual infrastructure
or instances that use the classic network.

Advantages
Compared with other Linux systems, Aliyun Linux 2 has the following advantages:
• Tailor-made for Alibaba Cloud ECS instances, featuring faster system startup and 

better runtime performance.
• Provides richer operating system features through the updated Linux kernel, user-

mode software, and toolkits.
• Streamlined kernel and reduced potential security risks.
• Free to use (technical support is available).

Features
New version of the Alibaba Cloud kernel
Aliyun Linux 2 is equipped with the latest version of the Alibaba Cloud kernel, which 
provides the following features:
• Customized based on version 4.19.24 that has been supported by the kernel 

community by adding new features for cloud scenarios, improving performance, 
and fixing major bugs.

• Customized and optimized kernel startup parameters and system configuration 
parameters intended for the ECS instance environment.
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• Kernel crash dumping (Kdump). You can enable or disable it without rebooting the
 operating system.

• Kernel Live Patching (KLP).
Software package
Aliyun Linux 2 is equipped with the Alibaba Cloud command line tool by default. The
package updates are as follows:
• network . service  is changed to systemd - networkd .
• The user mode package is compatible with CentOS 7.6.1810. That is, the user mode 

package of CentOS 7.6.1810 can be used on Aliyun Linux 2 directly.
• Fixes for Common Vulnerabilities and Exposures (CVEs) are continuously updated

until the end of life (EOL) of Aliyun Linux 2 is reached. For information about the
release notes of Aliyun Linux 2, see Release notes.

Performance optimization
Aliyun Linux 2 increases the boot speed and improves system performance at 
runtime, including:
• Greatly optimized startup speed for ECS instance environments.
• Optimized multi-threaded scenarios for ECS instance environments and improved 

multi-threaded performance for large-scale instances.
• Significantly improved performance thanks to full link optimization for MySQL

database scenarios (combined with ESSD cloud disks).
Get Aliyun Linux 2

Aliyun Linux 2 is officially available in the ECS console of Alibaba Cloud. You can use 
Aliyun Linux 2 in the following ways:
• Select Public Image and then Aliyun Linux 2 when creating an ECS instance. For

more information, see Create an instance by using the wizard.
• Update the operating system of an existing ECS instance to Aliyun Linux 2 by

replacing its system disk. For more information, see Replace the system disk by
using a public image.

Use Aliyun Linux 2
Updated system parameters
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Aliyun Linux 2 updated the following kernel configuration parameters in the
configuration file / etc / sysctl . d / 50 - aliyun . conf :
• kernel . hung_task_ timeout_se cs  = 240 : Increases the kernel

hung_task timeout seconds to avoid frequent hung_task prompts.
• kernel . panic_on_o ops  = 1 : Throws the Kernel Panic exception when

the kernel is experiencing an Oops error. Moreover, crash details are automatically
captured if Kdump is configured.

• kernel . watchdog_t hresh  = 50 : Increases the thresholds for events
such as hrtimer, NMI, Soft Lockup, and Hard Lockup to avoid possible kernel false
positives.

• kernel . hardlockup _panic  = 1 : Throws the Kernel Panic exception
when the kernel is experiencing a Hard Lockup error. Moreover, crash details are
automatically captured if Kdump is configured.

You can use the sysctl  command to view or modify the system parameters of
Aliyun Linux 2 at runtime.
Updated kernel parameters
Aliyun Linux 2 updated the following kernel parameters:
• crashkerne l = 0M - 2G : 0M , 2G - 8G : 192M , 8G -: 256M : Reserves

the memory space for the Kdump function.
• cryptomgr . notests : Turns off the self-check of crypto during kernel startup

to speed up the startup.
• cgroup . memory = nokmem : Turns off the kernel memory statistics function of

Memory Cgroup to avoid potential kernel instability.
• rcupdate . rcu_cpu_st all_timeou t = 300 : Increases the timeout

threshold of RCU CPU Stall Detector to 300 seconds to avoid kernel false positives.
Run the cat  / proc / cmdline  command to view the kernel startup parameters
of Aliyun Linux 2 at runtime.
Kernel version
Aliyun Linux 2 is equipped with the 4.19.24 version of Alibaba Cloud kernel by default
 (the current version is kernel-4.19.24-9.al7).
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You can install and switch to a v3.10 series kernel compatible with CentOS 7.6.1810 as
needed, and run the following command to roll back to a v3.10 kernel:

Note:
Replacing the kernel version may result in boot failure. Exercise caution when you
perform this operation.
sudo  yum  install  - y  kernel - 3 . 10 . 0
sudo  grub2 - set - default  "$( grep  ^ menuentry  / boot / grub2 /
grub . cfg  | grep  3 . 10 . 0  | awk  - F \' '{ print  $ 2  }')"
sudo  grub2 - mkconfig  - o  / boot / grub2 / grub . cfg

# Restart  the  system
sudo  reboot

Kdump
Aliyun Linux 2 provides the Kdump service. Kernel errors can be captured after the 
service is turned on, allowing you to analyze kernel crashes.
You can turn on/off the Kdump service by using the following command:
• Run the following command to turn on the Kdump service:

sudo  systemctl  enable  kdump . service
sudo  systemctl  restart  kdump . service

Note:
If the memory of the selected instance type is less than or equal to 2 GiB, the
Kdump service cannot be used.

• Run the following command to return the memory address space reserved by the
Kdump service to the operating system and turn off the Kdump service:
sudo  sh  - c  ' echo  0  > / sys / kernel / kexec_cras h_size '
sudo  systemctl  disable  kdump . service
sudo  systemctl  stop  kdump . service

Note:
After the memory address space reserved by the Kdump service is returned to the
operating system, the operating system must be restarted in order to enable the
Kdump service again.

Configure the network
Aliyun Linux 2 uses systemd - networkd  to configure the network by default.
When you configure the network, note the following:
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• The configuration file for DHCP or static IP addresses is located in the / etc /

systemd / network / directory.
• The command to restart the network is sudo  systemctl  restart  systemd

- networkd .
Get the Debuginfo package and the source code package
• Run the following command to get the Debuginfo package:

sudo  yum  install  - y  yum - utils
sudo  debuginfo - install  - y  < packageNam e >

• Run the following command to get the source package:
sudo  yum  install  - y  alinux - release - source
sudo  yum  install  - y  yum - utils
sudo  yumdownloa der  -- source  < sourcePack ageName >

Experimental software packages
Experimental software packages are provided by Alibaba Cloud, but not rigorously
tested. Therefore, their quality is not guaranteed. Aliyun Linux 2 provides the
following types of experimental packages:
• Ordinary experimental software packages

- Python  3 . 6

- Golang  1 . 11  and Golang  1 . 12

• Experimental software packages that support SCL plugins
- GCC  7 . 3 . 1

- GDB  8 . 0 . 1

- Binutils  2 . 28

- Make  4 . 2 . 1

Install a package:
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• Ordinary experimental software packages
1. Run the following command to enable YUM store:

sudo  yum  install  - y  alinux - release - experiment als

2. Run the following command to install a package:
sudo  yum  install  - y  < package  name >

• Experimental software packages that support SCL plugins
1. Run the following command to install scl - utils :

sudo  yum  install  - y  scl - utils

2. Run the following command to enable YUM store:
sudo  yum  install  - y  alinux - release - experiment als

3. Install the packages you need from the YUM source. The following command
installs GCC, GDB, Binutils, and Make tools.
sudo  yum  install  - y  devtoolset - 7 - gcc  devtoolset - 7
- gdb  devtoolset - 7 - binutils  devtoolset - 7 - make

After the installation is complete, you can use the newer version of GCC and
related tools. The sample code is as follows:
# To  view  an  existing  SCL , you  need  to  specify  
the  library  name :
scl  - l  devtoolset - 7

# Run  the  related  SCL  software :
scl  enable  devtoolset - 7  ' gcc  -- version '

Technical support
Alibaba Cloud provides the following technical support for Aliyun Linux 2:
• The version support period is 3 years, and the version life cycle is ended by March 

31, 2022.
• Security updates in the YUM source. You can run the yum  update  command to

update to the latest version.
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4.4 Known issues
This topic describes the known issues of Alibaba Cloud images on different platforms,
the scope of these issues, and the corresponding solution.

Debian 9.6: Classic network configuration
• Issue: Classic network instances created by using Debian 9 public images fail to be

pinged.
• Cause: Classic network instances cannot obtain IP addresses automatically

through the Dynamic Host Configuration Protocol (DHCP) because Debian 9
disables the systemd-networkd service by default.

• Image: debian_9_06_64_20G_alibase_20181212.vhd
• Solution: Run the following command:

systemctl  enable  systemd - networkd  
systemctl  start  systemd - networkd

CentOS 6.8: An instance installed with the NFS Client fails to respond
• Issue: An instance that is running CentOS 6.8 and has NFS Client installed fails

repeatedly to respond and must be restarted.
• Cause: When you use the NFS service, the NFS Client attempts to end the TCP

connection if a glitch occurs due to communication latency. Specifically, if the
NFS Server is delayed in sending a response to the NFS Client, the connection
initiated by the NFS Client may be stalled in the FIN_WAIT2 state. Normally,
the FIN_WAIT2 connection expires and closes after one minute and the NFS
Client initiates another connection. However, a kernel of version 2.6.32-696
to 2.6.32-696.10 has a defect in TCP connection establishment. As a result, the
FIN_WAIT2 connection will remain indefinitely, which means the NFS Client
cannot end the TCP connection and then initiate a new TCP connection.

• Image: centos_6_08_32_40G_alibase_20170710.vhd and
centos_6_08_64_20G_alibase_20170824.vhd

• Solution: Run the following command to upgrade the kernel to v2.6.32-696.11 or a
later version.
yum  update

Note:
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Before you perform any operations on the instance, you must create a snapshot to
back up your data.

CentOS 7: The hostname changes from uppercase to lowercase letters after the instance is
restarted

• Issue: After an ECS instance is restarted for the first time, the hostname of some
CentOS 7 instances is changed from uppercase letters to lowercase letters. The
following table shows some examples.
Hostname Hostname after the 

instance is restarted for 
the first time

Does the hostname 
remain in lowercase after 
the restart?

iZm5e1qe*****sxx1ps5zX izm5e1qe*****sxx1ps5zx Yes
ZZHost zzhost Yes
NetworkNode networknode Yes

• Image: The following CentOS public images (and custom images created based on
them) are affected:
- centos_7_2_64_40G_base_20170222.vhd
- centos_7_3_64_40G_base_20170322.vhd
- centos_7_03_64_40G_alibase_20170503.vhd
- centos_7_03_64_40G_alibase_20170523.vhd
- centos_7_03_64_40G_alibase_20170625.vhd
- centos_7_03_64_40G_alibase_20170710.vhd
- centos_7_02_64_20G_alibase_20170818.vhd
- centos_7_03_64_20G_alibase_20170818.vhd
- centos_7_04_64_20G_alibase_201701015.vhd

• Hostname: If your applications are sensitive to the letter casing of hostnames,
restarting such instances may affect the availability of corresponding services. The
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following table describes whether the hostname is changed after an instance is
restarted.
Current state of hostname Will the 

hostname 
change after
 an instance 
restart?

When will the
 change take 
effect?

The hostname contains uppercase letters at 
the time of instance creation (either in the ECS 
console or through APIs).

Yes When the 
instance is 
restarted for 
the first time.

The hostname contains no uppercase letters at 
the time of instance creation (either in the ECS 
console or through APIs).

No N/A

The hostname contains uppercase letters 
because the hostname is modified after you log 
on to an instance.

No N/A

• Solution: To retain uppercase letters in a hostname after you restart an instance,
follow these steps:
1. Connect to the target instance.
2. View the existing hostname:

[ root @ izbp193 ***** 3i161uynzz x  ~]# hostname
izbp193 ***** 3i161uynzz x

3. Run the following command:
hostnamect l  set - hostname  -- static  iZbp193 *****
3i161uynzz X

4. View the updated hostname.
[ root @ izbp193 ***** 3i161uynzz x  ~]# hostname
iZbp193 ***** 3i161uynzz X

• Additional actions: If you are using a custom image, we recommend that you
update the cloud-init software to the latest version and create a custom image
again. Such an action prevents the custom image from being affected by the
aforementioned issue. For more information, see Install cloud-init and Create a
custom image by using an instance.
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Linux: The pip requests time out
• Issue: The pip requests occasionally time out or fail.
• Image: CentOS, Debian, Ubuntu, SUSE, OpenSUSE, and Aliyun Linux.
• Cause: Alibaba Cloud provides the following three pip source addresses, and the

default address is mirrors.aliyun.com. To access this address, instances need to be
able to access Internet. If your instance has no public IP address assigned, a pip
request timeout will occur.
- (Default) Internet: mirrors.aliyun.com
- VPC intranet: mirrors.cloud.aliyuncs.com
- Classic network intranet: mirrors.aliyuncs.com
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• Solution: You can solve the problem through one of the following methods:
- Method 1

Assign a public IP address to your instance, that is, attaching an Elastic IP
address (EIP) to your instance. For more information, see Bind EIP to an ENI.
A Subscription instance can also be reassigned a public IP address through
changing its configurations. For more information, see Upgrade configurations
of Subscription instances.

- Method 2
Once a pip request fails, you can run the script fix_pypi . sh  in your ECS
instance and then retry the pip operation. The specific steps are as follows:
1. Connect to your ECS instance. For more information, see Connect to an

instance by using the Management Terminal.
2. Run the following command to get the script file:

wget  http :// image - offline . oss - cn - hangzhou .
aliyuncs . com / fix / fix_pypi . sh

3. Run the script.
■ For VPC instances, run the command bash  fix_pypi . sh  "

mirrors . cloud . aliyuncs . com ".
■ For Classic network instances, run the command bash  fix_pypi . sh

 " mirrors . aliyuncs . com ".
4. Retry the pip operation.
The content of fix_pypi . sh  is as follows:
#!/ bin / bash
function  config_pip () {

    pypi_sourc e =$ 1
    if  [[ ! - f  ~/. pydistutil s . cfg  ]]; then
cat  > ~/. pydistutil s . cfg  << EOF

[ easy_insta ll ]
index - url = http ://$ pypi_sourc e / pypi / simple /
EOF

    else
        sed  - i  “ s # index - url .# index - url = http ://$
pypi_sourc e / pypi / simple /#“ ~/. pydistutil s . cfg

    fi
    if  [[ ! - f  ~/. pip / pip . conf  ]]; then
    mkdir  - p  ~/. pip
cat  > ~/. pip / pip . conf  << EOF

[ global ]
index - url = http ://$ pypi_sourc e / pypi / simple /

[ install ]
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trusted - host =$ pypi_sourc e
EOF

    else
        sed  - i  “ s # index - url .# index - url = http ://$
pypi_sourc e / pypi / simple /#“ ~/. pip / pip . conf

        sed  - i  “ s # trusted - host .*# trusted - host =$
pypi_sourc e #” ~/. pip / pip . conf

    fi
}
config_pip  $ 1

Aliyun Linux 2: Enabling the CONFIG_PARAVIRT_SPINLOCK kernel feature causes performance
issues

• Issue: After you enable the CONFIG_PAR AVIRT_SPIN LOCK  kernel feature,
application performance is significantly impacted if there are a large number of
vCPUs in an ECS instance and lock contentions in applications. For example, timed
out connections degrade the performance of an Nginx application.

• Image: Aliyun Linux 2
• Solution: We recommend that you do not enable the CONFIG_PAR AVIRT_SPIN

LOCK  kernel feature for Aliyun Linux 2 (disabled by default).
Aliyun Linux 2: Setting the THP switch to always  impacts system stability and causes
performance issues

• Issue: After you set the Transparent Hugepage (THP) switch in your production
environment to always , the system becomes unstable and performance is
noticeably degraded.

• Image: Aliyun Linux 2
• Solution: Set the THP switch to madvise . In outlier scenarios (for example, if you

run some performance benchmark test suites), although performance is impacted
if this switch is set to madvise , we recommend that you do so to prevent the
system from being impacted by other contentions.

Aliyun Linux 2: A delegation conflict occurred in NFS v4.0
• Issue: A delegation conflict occurred in NFS v4.0. For more information, see 

Delegation in NFS Version 4.
• Image: Aliyun Linux 2
• Solution: We recommend that you do not enable the Delegation feature when you

use NFS v4.0. For information on how to disable this feature at the server side, see 
How to Select Different Versions of NFS on a Server.
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Aliyun Linux 2: NFS v4.1/4.2 has a defect that may cause logout failure of applications
• Issue: In NFS v4.1 or v4.2, if you use Asynchronous I/O (AIO) in applications to

distribute requests, and close the corresponding file descriptors before all I/Os are
returned, a livelock may be triggered and the corresponding process cannot be
ended.

• Image: Aliyun Linux 2
• Solution: This problem has been fixed in kernel v4.13.10-10.al7 and higher. To

upgrade the kernel version, run the command sudo  yum  update  kernel

- y

Notice:
- Upgrading the kernel may result in system boot failure. Please exercise caution 

when performing this action.
- Before you upgrade the kernel, make sure you have created a snapshot or

custom image to back up data. For more information, see Create a snapshot or
Create a custom image by using an instance.

Aliyun Linux 2: System performance is impacted when a high-risk security vulnerability (such as
Spectre or Meltdown) is fixed

• Issue: In the kernel of Aliyun Linux 2, the repair of high-risk security
vulnerabilities (Meltdown and Spectre) in processor hardware is enabled by
default, which impacts system performance. As a result, performance degradation
may be recorded during performance benchmark suite tests.

• Image: Aliyun Linux 2
• Solution: We recommend that in normal circumstances you do not disable the

repair function. However, if you need to maximize system performance, you can
run the following command to disable the repair function:
# Add  nopti  nospectre_ v2  to  the  kernel  startup  
parameters .
sudo  sed  - i  ' s /\( GRUB_CMDLI NE_LINUX =".*\)"/\ 1  nopti  
nospectre_ v2 "/' / etc / default / grub
sudo  grub2 - mkconfig  - o  / boot / grub2 / grub . cfg

# Restart  the  system .
sudo  reboot
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5 Custom image
5.1 Create custom image
5.1.1 Create a custom image by using a snapshot

Custom images allow you to create multiple ECS instances with identical OS and
environment data.
Custom images are based on ECS disk snapshots. You can set up identical or different 
configurations for ECS instances that are created from images.

You can also use an instance to create an image. For more information, see create a
custom image by using an instance.
To enhance the security of custom images created from snapshots, see security 
suggestions for Alibaba Cloud custom images.

Note:
• Custom images cannot be used across regions.
• You can change the operating system of an instance created from a custom image,

and the custom image remains usable. For details, see change the system disk
(custom image).

• You can upgrade the instance created from a custom image, including upgrading 
the CPU, memory, bandwidth, and disks.

• Custom images are created independently from the billing methods of the 
instances from which they were created. For example, custom images created 
from Subscription instances can used for creating Pay-As-You-Go instances. The 
converse method also applies.

• If the ECS instance used for creating a custom image expires, or the data is erased
 (that is, the system disk used for the snapshot expires or is released), the custom
 image and the ECS instances created from the custom image are not affected. 
However, automatic snapshots are cleared when an ECS instance is released.
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Restrictions for Linux instances
• Do not load data disk information in the / etc / fstab  file. Otherwise, instances

created using this image cannot start.
• We recommend that you umount  all data disks before creating a custom image,

and then use a snapshot to create a custom image. Otherwise, ECS instances that
are created based on this custom image may not start.

• Do not upgrade the kernel or operating system version.
• Do not change the system disk partitions. The system disk only supports single root

 partitions.
• We recommend you check the available space of the system disk to make sure that 

the system has available space.
• Do not modify critical system files such as / sbin , / bin , / lib , and so on.
• Do not modify the default logon user name root.

Procedure
1. Log on to the ECS console.
2. Select the region.
3. In the left-side navigation pane, click Instances.
4. Find the target instance and click its instance ID, or click Manage in the Actions

column.
5. In the left-side navigation pane, click Instance Snapshots. Find the target system

disk and then click Create Custom Image in the Actions column.
The snapshot must be created from system disks. Data disks cannot be used to 
create custom images. 
You can also click Snapshots and Images > Snapshots, and select a snapshot created
from a system disk to Create Custom Image.

6. In the Create Custom Image dialog box, complete the following:
• Confirm the snapshot ID.
• Enter a name and description of the custom image.
• Optional. Check Add Data Disk Snapshot, select multiple snapshots of data disks

for the image, and click Add to add a data disk.

Note:
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- We recommend that you remove sensitive data from the data disk before 
creating a custom image to guarantee data security.

- If the snapshot disk capacity is left blank, an empty disk is created with the 
default capacity of 5 GiB.

- If you select available snapshots, the disk size is the same as the size of the 
snapshots. 

7. Click Create. Then, in the left-side navigation pane, select Snapshots and Images >
Images to view the images you have created.

Linux instance image FAQ
How to umount  a disk and delete disk table data?
If / dev / hda5  is attached to / mnt / hda5 , run any of the following three
commands to detach the file system.
umount / dev / hda5
umount / mnt / hda5
umount / dev / hda5 / mnt / hda5

/ Etc / fstab  is an important configuration file in Linux. It contains the details
of mounting the file system and storage devices upon startup. If you do not want to
mount a specified partition when starting the instance, delete the corresponding
lines from / etc / fstab . For example, you can delete the following statement to
disconnect xvdb1 upon startup: / dev / xvdb1  / leejd  ext4  defaults  0

 0 .
How to determine whether a data disk is detached and a custom image can be created
?
You must make sure that the statement line for automatically attaching mounting 
data disk has been deleted from the fstab file.
Use the mount  command to view the information of all mounted devices. Make sure
that the execution results do not contain the information of the data disk partition.
Relevant configuration files
Before creating an image, make sure that the key configuration files listed in the 
following table have not been modified. Otherwise, the new instance cannot start.
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Configuration file Related to Risks if modified
/ etc / issue *, /
etc /*- release ,

and / etc /* _version

System release version Modifying /etc/issue* makes the 
system release version unidentifi
able, which can cause instance 
creation failure.

/ boot / grub / menu
. lst  and / boot /
grub / grub . conf

System startup Modifying /boot/grub/menu.lst 
results in kernel loading failure, 
which means the system cannot 
start.

/etc/fstab Partitions upon startup Modifying /etc/fstab causes 
partition mounting failure, 
which means the system cannot 
start.

/etc/shadow System passwords If this file is set to read-only, the
 password file cannot be edited, 
which means instance creation 
fails.

/etc/selinux/config System security policies Modifying /etc/selinux/config 
and enabling SELinux results in 
start failure.

5.1.2 Create a custom image by using an instance
You can create a custom image based on an ECS instance. That is, you can fully copy 
all its disks and pack the data into an image.
During this process, snapshots are automatically created for all disks of the instance
, including the system disk and data disks. All the created snapshots compose a new 
custom image. The following figure details this process.

For information about creating an image from a snapshot, see create a custom image
by using a snapshot.

Considerations
• Make sure you have deleted all confidential data in the ECS instance before 

creating a custom image to guarantee data security.
• During creation, do not change the status of the instance. Specifically, do not stop, 

start, or restart the instance.
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• If your custom image contains data disks, new data disks along with the ECS 
instance are created together. The data on the data disk duplicates the data disk 
snapshot in your custom image according to the mount device.

• You can export custom images that contain data disks.
• You cannot use a custom image which contains data disks to replace the system 

disk.
Procedure

1. Log on to the ECS console.
2. Select the target region.
3. In the left-side navigation pane, click Instances.
4. Find the target instance and click More > Disk and Image > Create Custom Image.
5. Enter a name and description for the image.
6. Click Create.

The image is available after all snapshots of all disks have been created.
Additional operation

See create a custom image by using a snapshot.
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5.1.3 Use Packer to create a custom image
This topic provides information about how to install and use Packer to create a
custom image.

Prerequisites
You must have an AccessKey.

Note:
Do not use the AccessKey of your Alibaba Cloud account. Instead, create a RAM user
and use the RAM account to create the necessary AccessKey to maintain account
security.

Step 1. Install Packer
Go to the official Packer download page where you can choose required version of
Packer for your operating system.
To install Packer on a Linux server
1. Connect and log on to the Linux server. If the server you want to connect to is an

ECS Linux instance, see connect to a Linux instance by using a password.
2. Run cd  / usr / local / bin  to go to the / usr / local / bin  directory.

Note:
The / usr / local / bin  directory is an environment variable directory. You
can install Packer to this directory or another directory that has been added to the
environment variable.

3. Run wget  https :// releases . hashicorp . com / packer / 1 . 1 . 1

/ packer_1 . 1 . 1_linux_am d64 . zip  to download the Packer installer.
You can visit the official download page of Packer to download installers for other
versions of Packer.

4. Run unzip  packer_1 . 1 . 1_linux_am d64 . zip  to unzip the package.
5. Run packer  - v  to verify Packer’s installation status. If the Packer version

number is returned, you have successfully installed Packer. If error command not
found is returned, Packer has not been correctly installed.

To install Packer on a Windows server
The following examples uses Windows Server 2012 64-bit:
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1. Connect and log on to the Windows server. If the server you want to connect to is
an ECS Windows instance, see connect to a Windows instance.

2. Open the official download page of Packer and select an appropriate Packer
installer for 64-bit Windows.

3. Unzip the package to a specified directory and install Packer.
4. Define the directory for Packer in the PATH environment variable.

a. Open the Control Panel.
b. Select All Control Panel Items > System > Advanced System Settings.
c. Click Environment Variable.
d. Find Path in the system variable list.
e. Add the Packer installation directory to the Variable Value, such as C :\

Packer  as seen in this example. Separate multiple directories with half-width
semicolons (;). Click OK.

5. Run packer . exe  - v  in CMD to verify Packer’s installation status. If the
Packer version number is returned, you have successfully installed Packer. If error
command not found prompt is returned, Packer has not been correctly installed.

Step 2. Define a Packer template

Note:
To create a custom image by using Packer, you must first create a JSON format
template file. In the template, you must specify theAlibaba Cloud Image Builder
 andProvisioner for the custom image to be created. Packer offers a diverse range of
provisioners for you to choose from when configuring the content generation mode
of the custom image. In the following JSON file example, the Shell provisioner is used
as an example to illustrate how to define a Packer template.

Create a JSON file named alicloud and paste the following content:
{
     " variables ": {
       " access_key ": "{{ env  ` ALICLOUD_A CCESS_KEY `}}",
       " secret_key ": "{{ env  ` ALICLOUD_S ECRET_KEY `}}"
     },
     " builders ": [{
       " type ":" alicloud - ecs ",
       " access_key ":"{{ user  ` access_key `}}",
       " secret_key ":"{{ user  ` secret_key `}}",
       " region ":" cn - beijing ",
       " image_name ":" packer_bas ic ",
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       " source_ima ge ":" centos_7_0 2_64_20G_a libase_201 70818
. vhd ",

       " ssh_userna me ":" root ",
       " instance_t ype ":" ecs . n1 . tiny ",
       " internet_c harge_type ":" PayByTraff ic ",
       " io_optimiz ed ":" true "
     }],
     " provisione rs ": [{
       " type ": " shell ",
       " inline ": [
         " sleep  30 ",
         " yum  install  redis . x86_64  - y "
       ]
     }]
   }
   

Note:
Customize the values of the following parameters according to your actual
requirements.
Parameter Description
access_key Your AccessKey ID. For more details, see

create an Accesskey.
secret_key Your AccessKey Secret. For more

information, see create an AccessKey.
region The region of the temporary instance 

used to create the custom image.
image_name The custom image’s name
source_image The name of the basic image name 

retrieved from Alibaba Cloud public 
image list.

instance_type Type of temporary instance generated to 
create the custom image.

internet_charge_type The Internet bandwidth billing method 
for the temporary instance generated for 
creating the custom image.

provisioners Type of Packer Provisioner used for
creating the custom image

Step 3. Create a custom image by using Packer
To specify the Packer template file and create a custom image, follow these steps:
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1. Run export  ALICLOUD_A CCESS_KEY = your  AccessKeyI D  to import
your AccessKey ID.

2. Run export  ALICLOUD_S ECRET_KEY = your  AccessKeyS ecret  to
import your AccessKey Secret.

3. Run packer  build  alicloud . json  to create the custom image.
The following example creates a custom image containing ApsaraDB for Redis and 
runs as follows:
alicloud - ecs  output  will  be  in  this  color .

==> alicloud - ecs : Prevalidat ing  alicloud  image  name ...
alicloud - ecs : Found  image  ID : centos_7_0 2_64_20G_a
libase_201 70818 . vhd

==> alicloud - ecs : Start  creating  temporary  keypair : 
packer_59e 44f40 - c8d6 - 0ee3 - 7fd8 - b1ba08ea94 b8

==> alicloud - ecs : Start  creating  alicloud  vpc
---------------------------
==> alicloud - ecs : Provisioni ng  with  shell  script : / var
/ folders / 3q / w38xx_js6c l6k5mwkrqs nw7w0000gn / T / packer -
shell25746 6182
alicloud - ecs : Loaded  plugins : fastestmir ror

---------------------------
alicloud - ecs : Total                                             

  1 . 3  MB / s  | 650  kB  00 : 00
alicloud - ecs : Running  transactio n  check

---------------------------
==> alicloud - ecs : Deleting  temporary  keypair ...
Build  ' alicloud - ecs ' finished .

==> Builds  finished . The  artifacts  of  successful  builds  
are :

--> alicloud - ecs : Alicloud  images  were  created :
cn - beijing : m - 2ze12578be 1oa4ovs6r9

What to do next
Use this custom image to create an ECS instance. For more information, see create an
instance from a custom image.

References
• For more information, visit packer-provider , the Packer repository of Alibaba

Cloud Github.
• See the Packer official documents to learn more about how to use Packer.

5.1.4 Create and import on-premises images by using Packer
Packer is a convenient open-source tool to create on-premises image files. It runs on
the most major operating systems.
By using Packer, you can create identical on-premises images for multiple platforms
 from a single source configuration. This topic details steps to create an on-premises 
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image for CentOS 6.9 on an Ubuntu 16.04 server and to upload it to Alibaba Cloud. For
 actual scenarios, you can customize your Packer templates as required.

Prerequisites
• You must have an AccessKey for the configuration file.

Note:
Do not use the AccessKey of your Alibaba Cloud account. Instead, create a RAM
user and use the RAM account to create the necessary AccessKey to maintain
account security.

• You must have purchased OSS.
Example of creating and importing an on-premises image

1. Run egrep  "( svm | vmx )" / proc / cpuinfo  to check whether your on-
premises server or virtual machine supports KVM. If the following output returns,
KVM is supported.
pat  pse36  clflush  dts  acpi  mmx  fxsr  sse  sse2
 ss  ht  tm  pbe  syscall  nx  pdpe1gb  rdtscp  lm  
constant_t sc  art  arch_perfm on  pebs  bts  rep_good  
nopl  xtopology  nonstop_ts c  aperfmperf  tsc_known_ freq
 pni  pclmulqdq  dtes64  monitor  ds_cpl  vmx  est  tm2  
ssse3  sdbg  fma  cx16  xtpr  pdcm  pcid  sse4_1  sse4_2  
x2apic  movbe  popcnt  tsc_deadli ne_timer  aes  xsave  avx
 f16c  rdrand  lahf_lm  abm  3dnowprefe tch  epb  intel_pt
 tpr_shadow  vnmi  flexpriori ty  ept  vpid  fsgsbase  
tsc_adjust  bmi1  avx2  smep  bmi2  erms  invpcid  mpx  
rdseed  adx  smap  clflushopt  xsaveopt  xsavec  xgetbv1
 xsaves  dtherm  ida  arat  pln  pts  hwp  hwp_notify  
hwp_act_wi ndow  hwp_epp
flags         : fpu  vme  de  pse  tsc  msr  pae  mce  cx8
 apic  sep  mtrr  pge  mca  cmov

2. Run the following commands to install the KVM:
sudo  apt - get  install  qemu - kvm  qemu  virt - manager  
virt - viewer  libvirt - bin  bridge - utils  # Install  KVM  
and  related  dependenci es .
sudo  virt - manager  # Enable  virt - manager .

If a GUI runs in the VM console window, you have successfully installed the KVM.
3. Install Packer.

To install Packer, see use Packer to create a custom image.
4. Run the following commands to define a Packer template.

Note:
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The on-premises image created in the following configuration is for the CentOS 6.9
operating system only. To create images for other operating systems, customize
the configuration file centos.json as required.
cd  / user / local  # Switch  the  directory .
wget  https :// raw . githubuser content . com / alibaba / packer
- provider / master / examples / alicloud / local / centos . json
 # Download  file  centos . json  that  is  released  by  
Alibaba  Cloud .
wget  https :// raw . githubuser content . com / alibaba / packer
- provider / master / examples / alicloud / local / http / centos
- 6 . 9 / ks . cfg  # Download  file  ks . cfg  that  is  
released  by  Alibaba  Cloud .
mkdir  - p  http / centos - 6 . 9  # Create  a  directory .
mv  ks . cfg  http / centos - 6 . 9 / # Move  file  ks . cfg  
to  the  http / centos - 6 . 9  directory .

5. Run the following commands to create an on-premises image.
export  ALICLOUD_A CCESS_KEY = SpecifyYou rAccessKey IDHere
 # Import  your  AccessKeyI D ,
export  ALICLOUD_S ECRET_KEY = SpecifyYou rAccessKey
SecretHere  # Import  your  AccessKeyS ecret .
packer  build  centos . json  # Create  an  on - premises  
image .

An example result is as follows.
qemu  output  will  be  in  this  color .
 ==> qemu : Downloadin g  or  copying  ISO
     qemu : Downloadin g  or  copying : http :// mirrors .
aliyun . com / centos / 6 . 9 / isos / x86_64 / CentOS - 6 . 9 -
x86_64 - minimal . iso
 ................................................
 ==> qemu : Running  post - processor : alicloud - import
     qemu  ( alicloud - import ): Deleting  import  source
 https :// oss - cn - beijing . aliyuncs . com / packer /
centos_x86 _64
 Build  ' qemu ' finished .
 ==> Builds  finished . The  artifacts  of  successful  
builds  are :
 --> qemu : Alicloud  images  were  created :
 cn - beijing : XXXXXXXX

6. Wait for a few minutes, log on to the ECS console and check your custom image
in the image list that is in the corresponding region. In this sample, the region is
China North 2 (cn-beijing).

Customize a Packer template
In this example, the following JSON file is customized based on the template used to 
create an image for the CentOS 6.9.
{" variables ": {
        " box_basena me ": " centos - 6 . 9 ",
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        " build_time stamp ": "{{ isotime  \" 2006010215 0405 \"}}",
        " cpus ": " 1 ",
        " disk_size ": " 4096 ",
        " git_revisi on ": " __unknown_ git_revisi on__ ",
        " headless ": "",
        " http_proxy ": "{{ env  ` http_proxy `}}",
        " https_prox y ": "{{ env  ` https_prox y `}}",
        " iso_checks um_type ": " md5 ",
        " iso_checks um ": " af4a1640c0 c6f348c6c4 1f1ea9e192 a2
",

        " iso_name ": " CentOS - 6 . 9 - x86_64 - minimal . iso ",
        " ks_path ": " centos - 6 . 9 / ks . cfg ",
        " memory ": " 512 ",
        " metadata ": " floppy / dummy_meta data . json ",
        " mirror ": " http :// mirrors . aliyun . com / centos ",
        " mirror_dir ectory ": " 6 . 9 / isos / x86_64 ",
        " name ": " centos - 6 . 9 ",
        " no_proxy ": "{{ env  ` no_proxy `}}",
        " template ": " centos - 6 . 9 - x86_64 ",
        " version ": " 2 . 1 . TIMESTAMP "
      },
    " builders ":[
        {
          " boot_comma nd ": [
            "< tab > text  ks = http ://{{ . HTTPIP  }}:{{ .
HTTPPort  }}/{{ user  ` ks_path `}}< enter >< wait >"

          ],
          " boot_wait ": " 10s ",
          " disk_size ": "{{ user  ` disk_size `}}",
          " headless ": "{{ user  ` headless ` }}",
          " http_direc tory ": " http ",
          " iso_checks um ": "{{ user  ` iso_checks um `}}",
          " iso_checks um_type ": "{{ user  ` iso_checks um_type
`}}",

          " iso_url ": "{{ user  ` mirror `}}/{{ user  ` mirror_dir
ectory `}}/{{ user  ` iso_name `}}",

          " output_dir ectory ": " packer -{{ user  ` template `}}-
qemu ",

          " shutdown_c ommand ": " echo  ' vagrant '| sudo  - S  /
sbin / halt  - h  - p ",

          " ssh_passwo rd ": " vagrant ",
          " ssh_port ": 22 ,
          " ssh_userna me ": " root ",
          " ssh_wait_t imeout ": " 10000s ",
          " type ": " qemu ",
          " vm_name ": "{{ user  ` template ` }}. raw ",
          " net_device ": " virtio - net ",
          " disk_inter face ": " virtio ",
          " format ": " raw "
        }
      ],
    " provisione rs ": [{
          " type ": " shell ",
          " inline ": [
                " sleep  30 ",
                " yum  install  cloud - util  cloud - init  - y "
              ]
        }],
      " post - processors ":[
        {
          " type ":" alicloud - import ",
          " oss_bucket _name ": " packer ",
          " image_name ": " packer_imp ort ",
          " image_os_t ype ": " linux ",
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          " image_plat form ": " CentOS ",
          " image_arch itecture ": " x86_64 ",
          " image_syst em_size ": " 40 ",
          " region ":" cn - beijing "
        }
      ]
}

Parameters in a Packer builder
QEMU builder is used in the preceding example to create a virtual machine image.
Required parameters for the builder are as follows.
Parameter Type Description
iso_checksum String The checksum for the OS ISO file. Packer

verifies this parameter before starting a virtual
machine with the ISO attached. Make sure
you specify at least one of the iso_checks
um  or iso_checks um_url  parameters.

If you have specified the iso_checks um
parameter, the iso_checks um_url  parameter
is automatically ignored.

iso_checks
um_type

String The type of the checksum specified in
iso_checksum. Optional values:
• none: If you specify none for iso_checks

um_type, the checksuming is ignored. This 
value is not recommended.

• md5
• sha1
• sha256
• sha512

iso_checks
um_url

String A URL that points to a GNU or BSD style checksum
file that contains the ISO file checksum of an
operating system. It may come in either the GNU
or BSD pattern. Make sure you specify either the 
iso_checks um  or the iso_checks um_url
 parameter. If you specify the iso_checksum

parameter, the iso_checks um_url  parameter
is automatically ignored.
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Parameter Type Description
iso_url String A URL that points to the ISO file, and contains the

installation image. This URL may be an HTTP URL
or a file path:
• If it is an HTTP URL, Packer downloads the file 

from the HTTP link and caches the file for later
.

• If it is a file path to the IMG or QCOW2 file,
QEMU directly starts the file. If you have the
file path specified, set parameter disk_image
to true .

headless boolean By default, Packer starts the virtual machine
GUI to build a QEMU virtual machine. If you set 
headless  to True , a virtual machine without

any console is started.
For more information, see Packer QEMU Builder.
Parameters in a Packer provisioner
The provisioner in the preceding example contains a Post-Processor module that
enables automated upload of on-premises images to Alibaba Cloud. Required
parameters for the provisioner are as follows:
Parameter Type Description
access_key String Your AccessKeyID. The AccessKey has a high

privilege. We recommend that you first create a
RAM user and use the RAM account to create an
AccessKey to maintain security of your Alibaba
Cloud account.

secret_key String Your AccessKeySecret. The AccessKey has a high
privilege. We recommend that you first create a
RAM user and use the RAM account to create an
AccessKey to maintain security of your Alibaba
Cloud account.

region String Select the region where you want to upload your
on-premises image. In this example, the region is
cn-beijing. For more information, see regions and
zones.
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Parameter Type Description
image_name String The name of your on-premises image. The name

 is a string of 2 to 128 characters. It must begin
 with an English or a Chinese character. It can 
contain A-Z, a-z, Chinese characters, numbers
, periods (.), colons (:), underscores (_), and 
hyphens (-).

oss_bucket
_name

String The OSS bucket name. If you specify a bucket 
name that does not exist, Packer creates a bucket 
automatically with the specified oss bucket name 
when uploading the image.

image_os_type String Image type. Optional values:
• linux
• windows

image_plat
form

String Distribution of the image. For example, CentOS.

image_arch
itecture

String The instruction set architecture of the image.
Optional values:
• i386
• x86_64

format String Image format. Optional values:
• RAW
• VHD

For more information, see Packer Alicloud Post-Processor.
Next step

You can use the created image to create an ECS instance. For more information, see
create an instance from a custom image.

References
• For more information about how to use Packer, see Packer documentation.
• For more information about release information, visit the Packer repository on

GitHub packer.
• For more information about Alibaba Cloud open source tools, visit the Alibaba

Cloud repository on GitHub opstools.
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• For more information about Alibaba Cloud and Packer project, visit the Alibaba
Cloud & Packer repositories on GitHub packer-provider.

• For more information about configuration file ks.cfg, see Anaconda Kickstart .

5.2 Modify custom images
This topic describes how to modify the name and description of your custom images.

Procedure
To modify the name and description of a custom image, follow these steps:
1. Log on to the ECS console.
2. In the left-side navigation pane, choose Instances & Images > Custom Images.
3. Find the target custom image and then click the  icon.
4. Enter a new name for the custom image.

5. In the Actions column, click Modify Description.
6. In the displayed dialog box, enter a Custom Image Description
7. Click Save.
Alternatively, you can modify the name and description of a custom image by calling
the ECS API ModifyImageAttribute.
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5.3 Import images
5.3.1 Image compliance tool

This topic describes how to use the image compliance tool provided by Alibaba Cloud
to check the validity of a custom Linux image and whether it meets the image import
conditions.

Background information
ECS allows you to create instances from custom images. However, the custom images
must meet certain requirements before they can be used in Alibaba Cloud. For more
information, see Notes for importing images.
To reduce the time needed to create a custom image, we recommend that you use the
 image compliance tool of ECS. The image compliance tool is designed to automatica
lly validate configuration items in a target Linux server environment to locate non
-compliant items, generate TXT and JSON detection reports, and provide possible 
troubleshooting actions if required.
This topic uses a server running the CentOS 7.4 64-bit OS as an example.

Scenarios
The image compliance tool currently supports Linux images only, such as Ubuntu, 
CentOS, Debian, RedHat, SUSE Linux Enterprise Server (SLES), OpenSUSE, FreeBSD, 
CoreOS, and other Linux versions.

Procedure
1. Log on to your server, VM, or cloud host.
2. Download the image compliance tool to the current directory of your server:

wget  http :// docs - aliyun . cn - hangzhou . oss . aliyun -
inc . com / assets / attach / 73848 / cn_zh / 1557459863 884 /
image_chec k

You can also download the image compliance tool directly.
3. Run the image compliance tool with root privileges to ensure that the image

compliance tool can read configuration files under permission control.
chmod  + x  image_chec k
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sudo  < path  of  the  image  compliance  tool >/ image_chec
k  – p  [ destinatio n  path ] 

In the preceding code example, < path  of  the  image  compliance  

tool > is also the path where the detection report is generated. Therefore, run
the following command to start the image compliance tool:
sudo  ./ image_chec k

Note:
You can use the - p  [ destinatio n  path ] command to specify the path
where the detection report is generated. If this parameter is not specified, the
detection report will be generated in the path of the image compliance tool by
default.

4. Wait for the image compliance tool to check the system configuration.
Begin  check  your  system ......
The  report  is  generating .
---------------------------------------
The  informatio n  you  need  to  input  when  you  import
 your  image  to  Alibaba  Cloud  website :
Current  system : CentOS
Architectu re : x86_64
System  disk  size : 42  GB
---------------------------------------
Check  driver                                                [  
OK   ]
Check  shadow  file  authority                                 [
  OK   ]
Check  security                                              [  
OK   ]
Check  qemu - ga                                               [  
OK   ]
Check  network                                               [  
OK   ]
Check  ssh                                                   [  
OK   ]
Check  firewall                                              [  
OK   ]
Check  filesystem                                            [  
OK   ]
Check  device  id                                             [  
OK   ]
Check  root  account                                          [  
OK   ]
Check  password                                              [  
OK   ]
Check  partition  table                                       [  
OK   ]
Check  lib                                                   [  
OK   ]
Check  disk  size                                             [  
OK   ]
Check  disk  use  rate                                         [
  OK   ]
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Check  inode  use  rate                                        [
  OK   ]
---------------------------------------
16  items  are  OK .
0  items  are  failed .
0  items  are  warning .
---------------------------------------
The  report  is  generated : / root / image_chec k_report_2
019 - 05 - 10_13 - 28 - 21 . txt
Please  read  the  report  to  check  the  details .

5. View the detection report.
The path of the detection report is displayed in the tool execution result.
In this example, the path is / root . The report is named in the format of
image_check_report_date_time.txt or image_chec k_report . json .

Detection items
The compliance tool detects the following server configuration items to ensure that 
the ECS instances created from your custom image are fully functional.
Detection item Non-compliance issue Suggestion
driver The ECS instance cannot start 

normally.
Install a virtualization driver.
For more information, see
#unique_65.

/etc/shadow You cannot modify the password
 file. As a result, you cannot 
create an ECS instance from the 
custom image.

Do not use the chattr
command to lock the / etc /
shadow  file.

SElinux The ECS instance cannot start 
normally.

Do not start SELinux by
modifying / etc / selinux /
config .

qemu-ga Some of the services required 
by ECS are unavailable, and the 
instance is not fully functional.

Uninstall qemu-ga.

network Network functions of the ECS 
instance are unstable.

Disable or delete the Network 
Manager and enable the network
 service.

ssh You cannot connect to the ECS
instance from the console.

Enable the SSH service and do 
not set PermitRootLogin.

firewall The system does not automatica
lly configure your ECS instance 
environment.

Disable the firewall iptables
, firewalld, IPFilter (IPF), 
IPFireWall (IPFW), or PacketFilt
er (PF).
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Detection item Non-compliance issue Suggestion
file system You cannot resize the disk. • The XFS, Ext3, and Ext4 file 

systems are recommended.
• The Ext2, UFS, and UDF file 

systems are allowed.
• Do not use the 64  bit

 feature for the Ext4 file
system.

Note:
The 64  bit  feature is one
feature of the Ext4 file system.
You can use the man  ext4

 command to view detailed
descriptions.

root You cannot use your username
 and password to remotely 
connect to the ECS instance.

Reserve the root account.

passwd You cannot add users to the ECS 
instance.

Retain or reinstall the passwd
command.

Partition table The ECS instance cannot start 
normally.

Use MBR partitioning.

/lib The ECS instance cannot be 
automatically configured.

The / lib  and / lib64  files
cannot be stored in absolute
paths. Modify the storage paths
of the files to their relative paths.

system disk N/A Increase the system disk 
capacity. The optimal system
 disk capacity is 40 GiB to 500 
GiB. When you import images
, configure the system disk 
capacity based on the virtual file
 size of images, instead of the 
usage capacity of images.

disk_usage You cannot install the necessary
 drivers or services for the ECS 
instance.

Make sure that sufficient disk 
space is allocated.
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Detection item Non-compliance issue Suggestion
inode usage You cannot install the necessary

 drivers or services for the ECS 
instance.

Make sure that sufficient inode 
resources are allocated.

The image compliance tool provides a detection result OK , FAILED , or WARNING

based on detection items.
• OK : The detection items all comply with requirements.
• FAILED : The detection items do not comply with requirements, which means

an ECS instance created from the custom image cannot start normally. We
recommend that you rectify the non-compliant items and recreate the image to
improve instance startup efficiency.

• WARNING : The detection items do not comply with requirements, which means
an ECS instance created from the custom image can start normally, but ECS cannot
use valid methods to configure your instance. You can choose to immediately
rectify the non-compliant items or temporarily retain the items and create an
image.

Output items
The image compliance tool generates detection reports in both TXT and JSON formats
in the destination path after it detects the system environment.

Note:
You can use the - p  [ destinatio n  path ] command to specify the path
where the detection report is generated. If this parameter is not specified, the
detection report will be generated in the path of the compliance tool by default.

• Reports in TXT format are named image_chec k_report_d ate_time . txt

. The reports include server configuration information and detection results. The
following example uses a server running the CentOS 7.4 64-bit OS.
The  informatio n  you  need  to  input  when  you  import
 your  image  to  Alibaba  Cloud  Website :
  Current  system  is : CentOS  # Server  operating  system
  Architectu re : x86_64  # System  architectu re
  System  disk  size : 42  GB  # Server  system  disk  
capacity
  -----------------------------------------
   Check  driver  # Detection  item  name
   Pass : kvm  drive  is  exist  # Detection  result
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   Alibaba  Cloud  supports  kvm  virtualiza tion  
technology
   We  strongly  recommend  installing  kvm  driver .

• Reports in JSON format are named image_chec k_report . json . The reports
include server configuration information and detection results. The following
example uses a server running the CentOS 7.4 64-bit OS.
" platform ": " CentOS ", \\ Server  operating  system
  " os_big_ver sion ": " 7 ", \\ Operating  system  version  
number  ( major )
  " os_small_v ersion ": " 4 ", \\ Operating  system  version  
number  ( minor )
  " architectu re ": " x86_64 ", \\ System  architectu re
  " system_dis k_size ": " 42 ", \\ Server  system  disk  
capacity
  " version ": " 1 . 0 . 2 ", \\ Compliance  tool  version
  " time ": " 2018 - 05 - 14_19 - 18 - 10 ", \\ Detection  time
  " check_item s ": [{
      " name ": " driver ", \\ Detection  item  name
      " result ": " OK ", \\ Detection  result
      " error_code ": " 0 ", \\ Error  code
      " descriptio n ": " Pass : kvm  driver  exists .", \\
Descriptio n
      " comment ": " Alibaba  Cloud  supports  kvm  virtualiza
tion  technology . We  strongly  recommend  installing  kvm  
driver ."
  }]
}

What to do next
1. View the notes for importing images.
2. #unique_65.
3. (Optional) Convert the image file format.
4. #unique_11.
5. #unique_9.

5.3.2 Notes for importing images
To guarantee a successful image import and usability of the image, the following
considerations must be noted before you import an image:

Windows images
Considerations
• Verify the integrity of the file system before you import images.
• Do not modify critical system files.
• Check that there is enough space on the system disk for the image to be installed.
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• Configure the system disk size for importing the image based on the virtual disk 
size rather than the used space of the image. The system disk size ranges from 40 
GiB to 500 GiB.

• Disable the firewall and allow access to RDP port 3389.
• The logon password for the administrator account must be 8 to 30 characters

in length and must contain three out of the four types of characterss, namely
small and capital letters, numbers, and special characters. Specifically, special
characters can be ( ) ` ~ ! @ # $ % ^ & * - _  + = | { } [ ] : ; ' <

> , . ? /. Additionally, the forward slash (/) cannot be the first character of the
password.

Not supported
• ISO images are not supported. However, you can create ISO images by using tools 

such as VirtualBox installed on-premises, and then convert the images to the RAW, 
VHD, or qcow2 format before importing them to Alibaba Cloud ECS.

• qemu-ga cannot be installed in the image because it will impact the availability of 
services needed by ECS.

• Images with the following operating systems cannot be imported: Windows XP, 
Windows 7 (professional and enterprise editions), Windows 8, and Windows 10.

Supported
• Multi-partition system disks.
• NTFS file systems and MBR partitions.
• Images in RAW, qcow2, or VHD format. If the target image is not in any of the

preceding formats, you need to convert image file format before importing it.
• Images of the following operating systems can be imported:

- Windows Server 2016
- Windows Server 2012 R2
- Windows Server 2012
- Windows Server 2008 R2
- Windows Server 2008
- Windows Server 2003 with Service Pack 1 (SP1) or higher

Linux images
Considerations
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• Verify the integrity of the file system before you import images.
• Do not modify critical system files, such as / sbin , / bin , and / lib *.

- Do not modify / etc / issue *. Otherwise, the system release cannot be
identified by ECS, which means the system cannot be created.

- Do not modify / boot / grub / menu . lst . Otherwise, the ECS instance
cannot be started.

- Do not modify / etc / fstab . Otherwise, the exception partition cannot be
loaded, which means the ECS instance cannot be started.

- Do not modify / etc / shadow  as Read-Only. Otherwise, the password file
cannot be modified, which means the system cannot be created.

- Do not modify / etc / selinux / config  to enable SELinux. Otherwise, the
system cannot be started.

• Check that there is enough space on the system disk for the image to be installed.
• Disable the firewall and allow access to SSH port 22.
• Enable Dynamic Host Configuration Protocol (DHCP).
• Install the virtualization platform XEN or KVM drives. For more information, see

Install the virtio driver.
• We recommended that you install cloud-init, so as to guarantee that hostname,

NTP, and yum sources can be configured successfully.
• The logon password for the root account must be 8 to 30 characters in length and

must contain three out of the four types of characterss, namely small and capital
letters, numbers, and special characters. Specifically, special characters can be ( )
` ~ ! @ # $ % ^ & * - _  + = | { } [ ] : ; ' < > , . ? /.

Not supported
• ISO images are not supported. However, you can create ISO images by using tools 

such as VirtualBox installed on-premises, and then convert the images to the RAW, 
VHD, or qcow2 format before importing them to Alibaba Cloud ECS.

• Multiple network interfaces.
• IPv6 addresses.
• System disk partitions cannot be adjusted. Currently, only a single root partition is

 supported.
• qemu-ga cannot be installed in the image because it will impact the availability of 

services needed by ECS.
64 Issue: 20190718



Elastic Compute Service Images /  5 Custom image

Supported
• Images in RAW, qcow2, or VHD format. If the target image is not in any of the

preceding formats, you need to convert image file format before importing it.
• xfs, ext3, and ext4 file systems and MBR partitions.

Note:
The ext4 file system cannot contain the feature 64bit , and the features 
project  and quota  cannot appear in pairs. To check the features, run the
tune2fs -l <ext4 file system disk directory> | grep features command
to view a list of features contained in the ext4 file system.

• Images of the following operating systems can be imported:
- Aliyun Linux
- CentOS 5/6/7
- CoreOS 681.2.0 and later
- Debian 6/7
- FreeBSD
- OpenSUSE 13.1
- RedHat
- RHEL (Red Hat Enterprise Linux)
- SUSE Linux 10/11/12
- Ubuntu 10/12/13/14/16/18

Non-standard image usage notes (Linux)
Any Linux images that are not listed as public images provided by ECS are considered
 as non-standard platform images. Such images do not comply with ECS requiremen
ts for a standard operating system regarding critical system configuration files, basic
 system environments, and applications. If you want to use a non-standard platform 
image, perform the following actions as indicated by the image type:
• Others Linux: Alibaba Cloud identifies all images of this type as other Linux

systems. Alibaba Cloud does not handle any instances created if you import an
image of Others Linux type. If you enable DHCP before you create an image,
Alibaba Cloud automatically configures your network. After creating the instance,
you need to connect to the instance by using the Management Terminal feature in
the console, and then manually configure the IP address, router, and password.
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• Customized Linux: Customized images. After importing a customized Linux image,
configure the network and password of the instance according to the standard
system configuration mode of Alibaba Cloud. For more information, see customize
Linux images.

5.3.3 Install cloud-init for Linux images
When you use a custom Linux image, we recommend that you install cloud-init in
your servers to guarantee successful initialization of the instances running that
image.

What is cloud-init?
cloud-init is an open source software used by cloud-based platforms to configure
system initialization of Linux instances. It is supported by major platforms such as
Alibaba Cloud, AWS, Azure, and OpenStack. For more information, see cloud-init 
documentation.
Alibaba Cloud cloud-init initializes the configurations of instances during their
startup, including the network, NTP, software source, host name, and SSH key pair. It
also executes the user data script.

Scenarios
Cloud-init is installed by default for all public images of Alibaba Cloud. If you use 
custom images in the following scenarios, we recommend that you install Alibaba 
Cloud cloud-init for your Linux servers so as to ensure the system configurations of 
created instances can be automatically initialized:
• Linux servers that will be migrated to Alibaba Cloud, but have not installed cloud-

init.
• Linux servers that have installed cloud-init whose version is earlier than 0.7.9.
• Alibaba Cloud ECS instances that have not installed cloud-init.

Check the cloud-init version
Different cloud platforms may use different versions of cloud-init. Please select the
appropriate version and configure the appropriate datasource. Alibaba Cloud uses
cloud-init 0.7.6a and the data source is Aliyun .
After cloud-init is installed, its option of self-start upon instance startup is enabled 
by default. If the selected cloud-init version or data source is not suitable, cloud-init 
may run abnormally and the instance may start slowly (or fail to start) the next time
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 you restart your instance. As a result, we recommend that you back up your data 
before you install it. Exercise caution when you install it if you are not fully ready to 
migrate your servers onto Alibaba Cloud.
• Check if cloud-init is installed: which  cloud - init

Note:
No output indicates that it is not installed and you need to install the Alibaba
Cloud cloud-init.

• Check the cloud-init version: cloud - init  -- version

Note:
If the version is earlier than the community version 0.7.9 (except 0.7.6a), you need
to install the Alibaba Cloud cloud-init.

(Recommended) Install the Alibaba Cloud cloud-init
1. Check and install the python-pip dependency.
2. Download the Alibaba Cloud cloud-init and decompress it to the current directory:

wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
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tar  - zxvf  ali - cloud - init - latest . tgz

3. Enter the tools  directory of cloud - init , and then run the cloud-init
installation script deploy . sh :
bash  ./ deploy . sh  < issue > < major_vers ion >

• The parameters are described as follows:
- issue : The operating system platform. The value range is: centos  | 

redhat  | rhel  | debian  | ubuntu  | opensuse  | sles . The parameter
values are case sensitive. sles  represents SUSE/SLES.

- major_vers ion : The major version of an operating system platform. For
example, the major version of CentOS 6.5 is 6 .

• The following are command examples:
- Install cloud-init in CentOS 6.5:

bash  ./ deploy . sh  centos  6

- Install cloud-init in Ubuntu 14.04:
bash  ./ deploy . sh  ubuntu  14

4. Confirm that the installation is successful. If " descriptio n ": " success " is
returned, the installation is successful.

Install the Alibaba Cloud cloud-init in different platforms
Installation commands for different platforms are shown as follows:
• CentOS 6/7

# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools ' >& / dev / null ; 
then
  yum  - y  install  python - pip
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud  / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
# Install  cloud - init
issue_majo r =$( cat  / etc / redhat - release  | awk  '{ printf
 $ 3 }' | awk  - F '.' '{ printf  $ 1 }')
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bash  ./ cloud - init -*/ tools / deploy . sh  centos  "$
issue_majo r "

• RHEL 6/7
# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools ' >& / dev / null ; 
then
  yum  - y  install  python - pip
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud  / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
# Install  cloud - init
issue_majo r =$( cat  / etc / os - release  | grep  VERSION_ID
 | awk  - F '"' '{ printf  $ 2 }' | awk  - F '.' '{ printf  $ 1
}')
bash  ./ cloud - init -*/ tools / deploy . sh  rhel  "$
issue_majo r "

• Ubuntu 14/16/18
# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools ' >& / dev / null ; 
then
  apt - get  install  python - pip  - y
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud  / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
# Install  cloud - init
issue_majo r =$( cat  / etc / os - release  | grep  VERSION_ID
 | awk  - F '"' '{ printf  $ 2 }' | awk  - F '.' '{ printf  $ 1
}')
bash  ./ cloud - init -*/ tools / deploy . sh  ubuntu  "$
issue_majo r "

• Debian 8/9
# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools ' >& / dev / null ; 
then
  apt - get  - y  install  python - pip
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud  / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
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# Install  cloud - init
issue_majo r =$( cat  / etc / os - release  | grep  VERSION_ID
 | awk  - F '"' '{ printf  $ 2 }' | awk  - F '.' '{ printf  $ 1
}')
bash  ./ cloud - init -*/ tools / deploy . sh  debian  "$
issue_majo r "

• SUSE 11/12
# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools '>& / dev / null ; then
  zypper  - n  install  python - pip
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
# Install  cloud - init
issue_majo r =$( cat  / etc / os - release  | grep  VERSION_ID
 | awk  - F '"' '{ printf  $ 2 }' | awk  - F '.' '{ printf  $ 1
}')
bash  ./ cloud - init -*/ tools / deploy . sh  sles  "$
issue_majo r "

• OpenSUSE 13/42
# Check  and  install  python - pip
if  ! python  - c  ' import  setuptools '>& / dev / null ; then
  zypper  - n  install  python - pip
fi
# Back  up  the  legacy  cloud - init  configurat ion
test  - d  / etc / cloud  && mv  / etc / cloud / etc / cloud -
old
# Download  and  decompress  the  Alibaba  Cloud  cloud -
init
wget  http :// ecs - image - utils . oss - cn - hangzhou .
aliyuncs . com / cloudinit / ali - cloud - init - latest . tgz
tar  - zxvf  ./ ali - cloud - init - latest . tgz
# Install  cloud - init
issue_majo r =$( cat  / etc / os - release  | grep  VERSION_ID
 | awk  - F '"' '{ printf  $ 2 }' | awk  - F '.' '{ printf  $ 1
}')
bash  ./ cloud - init -*/ tools / deploy . sh  opensuse "$
issue_majo r "

(Optional) Install the community cloud-init
Prerequisites
Before installing cloud-init, you must install the git, python 2.7, and python-pip 
dependencies. The installation commands are as follows:
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• CentOS/RedHat:
yum  - y  install  git  python  python - pip

• Ubuntu/Debian:
apt - get  - y  install  git  python  python - pip

• OpenSUSE/SUSE:
zypper  - n  install  git  python  python - pip

Procedure
1. Log on to the source server.
2. Download the cloud-init package through git and enter the cloud-init directory:

git  clone  https :// git . launchpad . net / cloud - init
cd  ./ cloud - init

3. Install all the dependencies:
pip  install  - r  ./ requiremen ts . txt

4. Install cloud-init:
python  setup . py  install

5. Run vi  / etc / cloud / cloud . cfg  to modify the configuration file
cloud.cfg.

Modify the configurations of cloud_init _modules : as follows:
# Example  datasource  config
# The  top  level  settings  are  used  as  module
# and  system  configurat ion .
# A  set  of  users  which  may  be  applied  and / or  
used  by  various  modules
# when  a  ' default ' entry  is  found  it  will  reference
 the  ' default_us er '
# from  the  distro  configurat ion  specified  below
users :
   - default
user :
    name : root
    lock_passw d : False
# If  this  is  set , ' root ' will  not  be  able  to  
ssh  in  and  they  
# will  get  a  message  to  login  instead  as  the  
above  $ user
disable_ro ot : false
# This  will  cause  the  set + update  hostname  module  to
 not  operate  ( if  true )
preserve_h ostname : false
syslog_fix _perms : root : root
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datasource _list : [ AliYun  ]
# Example  datasource  config
datasource :
    AliYun :
        support_xe n : false
        timeout : 5  # ( defaults  to  50  seconds )
        max_wait : 60  # ( defaults  to  120  seconds )
#      metadata_u rls : [ ' blah . com ' ]
# The  modules  that  run  in  the  ' init ' stage
cloud_init _modules :

What to do next
• For Linux servers that are ready for migration to the cloud, you can migrate them

to Alibaba Cloud by using the Cloud Migration tool or import custom images.
• For ECS instances with custom Linux images that are already running on Alibaba

 Cloud, you can restart the system for verification. If the system is automatically 
configured with the host name, software source, and NTP, cloud-init is successfully
 installed.

Troubleshooting

Note:
• The libraries that are missing may vary according to the images. To resolve this 

issue, you can install them through pip, and then install cloud-init again.
• If the default package manager (for example yum ) and the pip  manager have

installed different versions of libraries, library version conflicts may occur and
lead to cloud-init running abnormally. We recommend that you download the
dependency libraries according to the reported errors.

Error: no setuptools module in python
The error prompt no  setuptools  module  in  python  means you need to
install python setuptools. You can fix it in the following ways:
• CentOS/RedHat: yum  - y  install  python - pip

• Ubuntu/Debian: apt - get  - y  install  python - pip

• OpenSUSE/SUSE: zypper  - n  install  python - pip

Error: No module named six
Run pip  install  six  to resolve the following error.
File  "/ root / cloud - init / cloudinit / log . py ", line  19 , 
in  < module >

      import  six
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  ImportErro r : No  module  named  six   )

Error: No module named oauthlib.oauth1
Run pip  install  oauthlib  to resolve the following error.
File  "/ root / cloud - init / cloudinit / url_helper . py ", line  
20 , in  < module >

      import  oauthlib . oauth1  as  oauth1
  ImportErro r : No  module  named  oauthlib . oauth1   )

Error messages do not indicate the missing libraries
If error messages do not indicate the missing libraries during installation, you can
install all the dependency libraries displayed in the file requirements.txt of cloud-init.
pip  install  - r  requiremen ts . txt

References
cloud-init website - Alibaba Cloud (AliYun)

5.3.4 Install virtio driver
This topic details which images do and do not require the virtio driver to be installed
on the source server before import.

Images requiring no manual installation
After you import custom images, if the operating systems of your images are listed as
follows, Alibaba Cloud automatically processes the virtio driver for you:
• Windows Server 2008
• Windows Server 2012
• Windows Server 2016
• CentOS 6/7
• Ubuntu 12/14/16
• Debian 7/8/9
• SUSE 11/12
You can skip to recover the temporary root file system of initramfs or initrd.

Images requiring manual installation
For Linux images that are not included in the preceding list, you must install the 
virtio driver on-premises before importing the images.
To check the availability of virtio driver on a server
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1. Run grep  - i  virtio  / boot / config -$( uname  - r ) to inspect
whether the virtio driver is already built in the kernel of your server.

Note:
• If VIRTIO_BLK and VIRTIO_NET do not exist in the output, the virtio driver is

not built in the kernel. You must install and configure the virtio driver on your
server to compile and install virtio driver.

• If the values of parameter CONFIG_VIR TIO_BLK  and parameter 
CONFIG_VIR TIO_NET  are y , the virtio driver is already built in the kernel.

For more information, see notes for importing images and import custom
images.

• If the values of parameter CONFIG_VIR TIO_BLK  and parameter 
CONFIG_VIR TIO_NET  are m , continue to step 2.

2. Run lsinitrd  / boot / initramfs -$( uname  - r ). img  | grep  

virtio  to make sure the virtio driver has been complied in the temporary root
file system of initramfs or initrd.

Note:
• According to the preceding figure, the virtio_blk driver, including its

dependency virtio.ko, virtio_pci.ko and virtio_ring.ko, has been compiled in
the temporary root file system initramfs. For more information, see notes for
importing images and import custom images.

• If virtio driver is unavailable in the initramfs, you must recover the temporary 
root file system of initramfs or initrd before importing images or migration.

To recover the temporary root file system
If the virtio driver is supported by the kernel but not compiled in the temporary root 
file system, you must recover the temporary root file system. The following example 
uses CentOS:
• CentOS/RedHat 5

mkinitrd  - f  -- allow - missing  \
            -- with = xen - vbd   -- preload = xen - vbd  \
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            -- with = xen - platform - pci  -- preload = xen -
platform - pci  \
            -- with = virtio_blk  -- preload = virtio_blk  \
            -- with = virtio_pci  -- preload = virtio_pci  \
            -- with = virtio_con sole  -- preload = virtio_con
sole  \

• CentOS/RedHat 6/7
mkinitrd  - f  -- allow - missing  \
            -- with = xen - blkfront  -- preload = xen - blkfront  \
            -- with = virtio_blk  -- preload = virtio_blk  \
            -- with = virtio_pci  -- preload = virtio_pci  \
            -- with = virtio_con sole  -- preload = virtio_con
sole  \
            / boot / initramfs -$( uname  - r ). img  $( uname  - r
)

• Debian/Ubuntu
echo  - e  ' xen - blkfront \ nvirtio_bl k \ nvirtio_pc i \
nvirtio_co nsole ' >> \
/ etc / initramfs - tools / modules
mkinitramf s  - o  / boot / initrd . img -$( uname  - r )"

To compile and install virtio driver
The following example uses a Red Hat server:
To download the kernel package
1. Run yum  install  - y  ncurses - devel  gcc  make  wget  to install

necessary components to compile the kernel.
2. Run uname  - r  to query the kernel version of your server, such as

4.4.24-2.a17.x86_64.

3. Visit published Linux Kernel Archives to download the source codes of kernel, for
example, the download link of kernel version starting with 4.4.24 is https://www.
kernel.org/pub/linux/kernel/v4.x/linux-4.4.24.tar.gz.

4. Run cd  / usr / src / to change the directory.
5. Run wget  https :// www . kernel . org / pub / linux / kernel / v4 .

x / linux - 4 . 4 . 24 . tar . gz  to download the installation package.
6. Run tar  - xzf  linux - 4 . 4 . 24 . tar . gz  to decompress the

package.
7. Run ln  - s  linux - 4 . 4 . 24  linux  to establish a link.
8. Run cd  / usr / src / linux  to change the directory.
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To compile the kernel
1. Run the following commands to compile the driver into the kernel.

make  mrproper
 symvers_pa th =$( find  / usr / src / - name  " Module . symvers
")
 test  - f  $ symvers_pa th  && cp  $ symvers_pa th  .
 cp  / boot / config -$( uname  - r ) ./. config
 make  menuconfig

2. Configure the corresponding settings of virtio driver in the following windows:

Note:
Select * to build the driver in the kernel, select m  to compile it as a module.

a. Press the space bar to select Virtualization.

Make sure that you have selected the option of KVM (Kernel-based Virtual 
Machine).

Processor  type  and  features   --->
   [*] Paravirtua lized  guest  support   --->
     --- Paravirtua lized  guest  support
 ( 128 )   Maximum  allowed  size  of  a  domain  in  
gigabytes

 [*]   KVM  paravirtua lized  clock
 [*]   KVM  Guest  support

Device  Drivers   --->
  [*] Block  devices   --->
 < M >   Virtio  block  driver  ( EXPERIMENT AL )
 -*- Network  device  support   --->
     < M >   Virtio  network  driver  ( EXPERIMENT AL )

b. Press the Esc key to exit the kernel configuration windows, and save changes to 
file .config according to the dialog box.

c. Inspect whether all the corresponding settings of virtio driver has been 
correctly configured or not.

d. (Optional) If no configuration of virtio driver is settled after the inspect, run the
following commands to edit the file .config manually.
make  oldconfig
make  prepare
make  scripts
make
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make  install

e. Run the following commands to check whether the virtio driver is installed.

find  / lib / modules /"$( uname  - r )"/ - name  " virtio .*" | 
grep  - E  " virtio .*"
grep  - E  " virtio .*" < / lib / modules /"$( uname  - r )"/
modules . builtin

Note:
If any of the output includes virtio_blk and virtio_pci.virtio_console, your
server has correctly installed the virtio driver.

What to do next
After compiling the virtio driver, you can migrate your server to Alibaba Cloud by
using the Cloud Migration Tool.

5.3.5 Customize Linux images
If your selected OS is not supported by Alibaba Cloud, and cloud-int cannot be
installed, you can select Customized Linux when importing a customized image.
Alibaba Cloud will then regard the customized Linux image as an unrecognized OS
type (that is, it lacks necessary standard configuration information for ECS instance
start for the first time). In this case, you need to add a parsing script to the customized
image before importing the image, so as to facilitate automatic configuration of the
instance at the first start.

Limitations
• The first partition of the customized Linux image must be writable.
• The first partition type of the customized Linux image must be FAT32, EXT2, EXT3, 

EXT4, or UFS.
• The size of the virtual file of the customized Linux image must be larger than 5 GiB.
• Security requirements for customized Linux images are as follows:

- There is no high-risk vulnerability that can be remotely exploited.
- When you log on to an instance for the first time through the Management

Terminal of the ECS console, you must change the initial default password (if
there is any) before performing subsequent actions.

- There is no default SSH private key pair. The initial SSH private key pair must be
 randomly generated by Alibaba Cloud.
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Procedure
1. Create the aliyun_cus tom_image  directory in the root directory of the first

image partition.
When the instance that is created using the customized Linux image is started for
the first time, Alibaba Cloud will write configuration information into the os.conf
file in the aliyun_cus tom_image  directory. Alibaba Cloud will automatically
create an os.conf file if there is none.

2. Create a parsing script in the image to parse system configurations of the os.conf
file. For details about how to write a script, see attentions on script parsing and
parsing script example.

Example of the os.conf file
For instances using classic networks
hostname = iZ23r29djm jZ
password = cXdlcjEyMz QK
eth0_ip_ad dr = 10 . 171 . 254 . 123
eth0_mac_a ddr = 00 : 8c : fa : 5e : 14 : 23
eth0_netma sk = 255 . 255 . 255 . 0
eth0_gatew ay = 10 . 171 . 254 . 1
eth0_route =" 10 . 0 . 0 . 0 / 8  10 . 171 . 254 . 1 ; 172 . 16 . 0
. 0 / 12  10 . 171 . 254 . 1 "
eth1_ip_ad dr = 42 . 120 . 74 . 105
eth1_mac_a ddr = 00 : 8c : fa : 5e : 14 : 24
eth1_netma sk = 255 . 255 . 255 . 0
eth1_gatew ay = 42 . 120 . 74 . 1
eth1_route =" 0 . 0 . 0 . 0 / 0  42 . 120 . 74 . 1 "
dns_namese rver =" 7 . 7 . 7 . 7  8 . 8 . 8 . 8 "

The following table describes the parameters.
Parameter Parameter description
hostname The host name
password The password, which is Base64-encoded
eth0_ip_addr The IP address of the eth0 NIC
eth0_mac_addr The MAC address of the eth0 NIC
eth0_netmask The network mask of the eth0 NIC
eth0_gateway The default gateway of the eth0 NIC
eth0_route The eth0 intranet route list, in which routes are separated 

by semicolons (;) by default
eth1_ip_addr The IP address of the eth1 NIC
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Parameter Parameter description
eth1_mac_addr The MAC address of the eth1 NIC
eth1_netmask The network mask of the eth1 NIC
eth1_gateway The default gateway of the eth1 NIC
eth1_route The eth1 internet route list, in which routes are separated 

by semicolons (;) by default
dns_nameserver The DNS address list, in which addresses are separated by 

spaces by default
For instances using VPCs
hostname = iZ23r29djm jZ
password = cXdlcjEyMz QK
eth0_ip_ad dr = 10 . 171 . 254 . 123
eth0_mac_a ddr = 00 : 8c : fa : 5e : 14 : 23
eth0_netma sk = 255 . 255 . 255 . 0
eth0_gatew ay = 10 . 171 . 254 . 1
eth0_route =" 0 . 0 . 0 . 0 / 0  10 . 171 . 254 . 1 "
dns_namese rver =" 7 . 7 . 7 . 7  8 . 8 . 8 . 8 "

The following table describes the parameters.
Parameter Parameter description
hostname The host name
password The password, which is Base64-encoded
eth0_ip_addr The IP address of the eth0 NIC
eth0_mac_addr The MAC address of the eth0 NIC
eth0_netmask The network mask of the eth0 NIC
eth0_gateway The default gateway of the eth0 NIC
eth0_route The eth0 intranet route list, in which routes are separated 

by semicolons (;) by default
dns_nameserver The DNS address list, in which addresses are separated by 

spaces by default
Script parsing considerations

In normal cases, when an instance is started for the first time, Alibaba Cloud
automatically writes information about configuration items into the os.conf file in
the aliyun_cus tom_image  directory in the root directory of the first partition. To
configure a customized Linux image, you must create a pre-defined parsing script in
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the image. Then, Alibaba Cloud reads configuration information about the instance
from the os.conf file to complete instance configuration. The following conditions
must be met for script parsing:
• Automatic start: The parsing script should be automatically started. To do so, place

the script in the / etc / init . d / directory.
• Configuration item value rules: As described in example of the os.conf file ,

instances using classic networks and those using VPCs differ in rules of the
number of configuration items and values of some configuration items.

• Configuration file read path: By default, names of the devices allocated for the
first partition vary with types of the instances created for the customized Linux
image, including I/O optimization instances and non-I/O optimization instances.
Therefore, you are recommended to use uuid  or label  to indicate devices
in the first partition. Because the user password is a Base64-encoded string, it
therefore must be Base64-encoded in the script.

• Network type: When using the parsing script to determine the network type, you
can check whether there is eth1_route  or other eth1-related configuration item.
To do so, parse and process the instance accordingly after determining whether it
uses a classic network or VPC.
- Instances using VPCs are configured with Internet routes that are specified by

the eth0_route  parameter in the os.conf file.
- Instances using classic networks are configured with Internet routes that are

specified by the eth1_route  parameter in the os.conf file, and intranet routes
are specified by the eth0_route  parameter.

• Configuration optimization: Configurations in the os.conf file are executed only
once during the instance life cycle. You are recommended to delete the os.conf
file after the parsing script is successfully executed. The parsing script does not
execute configurations in the os.conf file if it does not read any.

• Customized image processing: When you create a customized image based on the
customized Linux image, the script requiring automatic start is also included in the
new image. Alibaba Cloud will write os.conf file configurations when the instance
is started for the first time. Then, the parsing script immediately executes the
configurations upon detection.

• Configuration change processing: When instance configurations are changed
through the Alibaba Cloud console or APIs, Alibaba Cloud writes related
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information into the os.conf file. Then, the parsing script executes the
configurations again to issue the changes.

Parsing script example
The following uses a parsing script used for CentOS as an example. You can change
 the script content as needed. Make sure that the script has been successfully 
debugged in the image before you use the script.
#! / bin / bash

### BEGIN  INIT  INFO
# Provides :          os - conf
# Required - Start :    $ local_fs  $ network  $ named  $ remote_fs
# Required - Stop :
# Should - Stop :
# Default - Start :     2  3  4  5
# Default - Stop :      0  1  6
# Short - Descriptio n : The  initial  os - conf  job , config
 the  system .

### END  INIT  INFO

first_part ition_dir ='/ boot /'
os_conf_di r =${ first_part ition_dir }/ aliyun_cus tom_image
os_conf_fi le =${ os_conf_di r }/ os . conf

load_os_co nf () {
 if  [[ - f  $ os_conf_fi le  ]]; then
  . $ os_conf_fi le
  return  0
 else
  return  1
 fi
}

cleanup () {
 # ensure  $ os_conf_fi le  is  deleted , to  avoid  repeating
 config  system

 rm  $ os_conf_fi le  >& / dev / null
 # ensure  $ os_conf_di r  is  exitst
 mkdir  - p  $ os_conf_di r
}

config_pas sword () {
 if  [[ - n  $ password  ]]; then
  password =$( echo  $ password  | base64  - d )
  if  [[ $? == 0  && - n  $ password  ]]; then
   echo  " root :$ password " | chpasswd
  fi
 fi
}

config_hos tname () {
 if  [[ - n  $ hostname  ]]; then
  sed  - i  " s /^ HOSTNAME =. */ HOSTNAME =$ hostname /" / etc /
sysconfig / network

  hostname  $ hostname
 fi
}
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config_dns () {

 if  [[ - n  $ dns_namese rver  ]]; then
  dns_conf =/ etc / resolv . conf
  sed  - i  '/^ nameserver .*/ d ' $ dns_conf
  for  i  in  $ dns_namese rver ; do
   echo  " nameserver  $ i " >> $ dns_conf
  done
 fi
}

is_classic _network () {
 # vpc : eth0
 # classic : eth0  eth1
 grep  - q  ' eth1 ' $ os_conf_fi le
}

config_net work () {
 / etc / init . d / network  stop
 config_int erface  eth0  ${ eth0_ip_ad dr } ${ eth0_netma sk }
 ${ eth0_mac_a ddr }
 config_rou te  eth0  ${ eth0_route }
 if  is_classic _network  ; then
  config_int erface  eth1  ${ eth1_ip_ad dr } ${ eth1_netma sk }
 ${ eth1_mac_a ddr }
  config_rou te  eth1  ${ eth1_route }
 fi
 / etc / init . d / network  start
}

config_int erface () {
 local  interface =$ 1
 local  ip =$ 2
 local  netmask =$ 3
 local  mac =$ 4
 inteface_c fg ="/ etc / sysconfig / network - scripts / ifcfg -${
interface }"

 cat  << EOF  > $ inteface_c fg
DEVICE =$ interface
IPADDR =$ ip
NETMASK =$ netmask
HWADDR =$ mac
ONBOOT = yes
BOOTPROTO = static
EOF

}

config_def ault_gatew ay () {
 local  gateway =$ 1
 sed  - i  " s /^ GATEWAY =. */ GATEWAY =$ gateway /" / etc /
sysconfig / network

}

config_rou te () {
 local  interface =$ 1
 local  route =$ 2
 route_conf =/ etc / sysconfig / network - scripts / route -${
interface }

 > $ route_conf
 echo  $ route  | sed  ' s /;/\ n /' | \
  while  read  line ; do
   dst =$( echo  $ line  | awk  '{ print  $ 1 }')
   gw =$( echo  $ line  | awk  '{ print  $ 2 }')
   if  ! grep  - q  "$ dst " $ route_conf  2 > / dev / null ; 
then
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    echo  "$ dst  via  $ gw  dev  $ interface " >> $ route_conf
   fi
   if  [[ "$ dst " == " 0 . 0 . 0 . 0 / 0 " ]]; then
    config_def ault_gatew ay  $ gw
   fi
  done
}

################## sysvinit  service  portal  ####################

start () {
 if  load_os_co nf  ; then
  config_pas sword
  config_net work
  config_hos tname
  config_dns
  cleanup
  return  0
 else
  echo  " not  load  $ os_conf_fi le "
  return  0
 fi
}

RETVAL = 0

case  "$ 1 " in
    start )
        start
        RETVAL =$?
    ;;
    *)
        echo  " Usage : $ 0  { start }"
        RETVAL = 3
    ;;
esac

exit  $ RETVAL

5.3.6 Convert image file format
Only image files in qcow2, RAW, or VHD format can be imported. If you want to
import images in other formats, you need to convert the format before importing the
image. This topic describes how to use the qemu-img tool to convert other image file
formats to VHD or RAW. Using qemu-img, you can convert RAW, qcow2, VMDK, VDI,
VHD (vpc), VHDX, qcow1, or QED, to VHD, or implement conversion between RAW
and VHD.

Windows
To install qemu-img and convert the image file format, follow these steps:
1. Log on to your server or VM, download qemu-img and complete the installation.

Installation path: C :\ Program  Files \ qemu .
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2. Perform the following actions to create an environment variable for qemu-img:
a. Choose Start > Computer, then right-click Properties.
b. In the left-side navigation pane, click Advanced System Settings.
c. In the System Properties dialog box, click the Advanced tab, and then click

Environment Variables.
d. In the Environment Variables dialog box, find the Path variable in the System

Variables part, and then click Edit. If the Path variable does not exist, click New.
e. Add a system variable value:

• In the case of Edit System Variable: In the Variable Value field, add C :\

Program  Files \ qemu . Different variable values are separated with a
semicolon (;).

• In the case of New System Variable: In the Variable Name field, enter Path .
In the Variable Value field, enter C :\ Program  Files \ qemu .

3. Open Command Prompt in Windows and run the qemu - img  -- help

 command. If the result is displayed correctly, the environment variable is
configured successfully.

4. In the Command prompt, run the cd  [ directory  of  the  source  

image  file ] command to change the directory. For example, cd  D :\

ConvertIma ge .
5. Run the qemu - img  convert  - f  qcow2  - O  raw  centos . qcow2

 centos . raw  command to convert the image file format. Where:
• - f  is followed by the source image format.
• - O  (uppercase is required) is followed by the converted image format, the

source file name, and the target file name.
When the conversion is complete, the target file appears in the directory where the 
source image file is located.

Linux
To install qemu-img and convert the image file format, follow these steps:
1. Install qemu-img, for example:

• For Ubuntu, run the command apt - get  install  qemu - utils .
• For CentOS, run the command yum  install  qemu - img .
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2. Run the qemu - img  convert  - f  qcow2  - O  raw  centos . qcow2

 centos . raw  command to convert the image file format. Where:
• - f  is followed by the source image format.
• - O  (uppercase is required) is followed by the converted image format, the

source file name, and the target file name.
When the conversion is complete, the target file appears in the directory where the
source image file is located.

FAQ
• What do I do if an error occurs during qemu-img installation and the error 

message does not indicate which dependent libraries are missing?
Run pip  install  - r  requiremen ts . txt  to install all the dependent
libraries based on the libraries contained in the requiremen ts . txt  file of
cloud-init.

• What do I do if the error Unable  to  locate  package  qemu - utils  is
returned during the installation of qemu-img on the Ubuntu?
Run the following commands to install qemu-img:
apt - get  update  # Updating  the  package  list
apt - get  install  qemu - utils  # Installing  qemu - img

What to do next
Import custom images.

5.3.7 Import custom images
You can import on-premises image files to your ECS environment to create ECS
instances or change system disks

Note:
• The time it takes to import an image depends on the size of the image file and the 

number of concurrent tasks.
• When you import an image, a snapshot is automatically generated. You can view

the snapshot information on the Snapshots page in the ECS Console. Before the
import image task is completed, the status of the snapshot is displayed as Failed.
When the task is completed, the status is automatically updated to Successful. The
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snapshot capacity is the size of the imported image file, regardless of the system
disk size that was set when the image was imported.

Prerequisites
Before importing an image, we recommend that you:
• Review the notes for importing images, customize Linux images, and convert

image format to understand the limitations of importing an on-premises image.
• Activate OSS.
• (Optional) If you are using a RAM sub-account, you need to contact the master

account in advance to obtain the permission for the AliyunECSI mageImport

DefaultRol e  role.
Procedure

To import custom images in the ECS console, follow these steps:
1. Use an OSS third-party client, OSS API or OSS SDK to upload the prepared custom

image. If the file you want to upload is larger than 5 GiB, see multipart upload.
2. Log on to the ECS console.
3. In the left-side navigation pane, choose Snapshots and Images > Images.
4. Click Import Image.
5. In the Import Image dialog box, click Confirm Address as follows.
6. In the Cloud Resource Access Authorization window, select AliyunECSI

mageImport DefaultRol e  and AliyunECSE xportDefau ltRole , then
click Confirm Authorization Policy to allow the ECS service to access your OSS
resources.

7. On the Images page, click Import Image again.
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8. In the Import Image dialog box, enter the following information:
• Region of Image: Select the region where the OSS Bucket of the image file to

upload is located.
• OSS Object Address: Copy the object address of the image file from the OSS

console. For more information, see download an object.
• Image Name: Enter a name for the custom image. The name must be 2 to 128

characters in length and can contain letters, numbers, Chinese characters,
periods (.), underscores (_), colons (:), and hyphens (-).

• Operating System: Select Windows or Linux, that is, the same as that of your
image. If you want to import a non-standard platform image, select Linux.

• System Disk Size: The system disk size, which ranges from 40 GiB to 500 GiB.
• System Architecture: Choose x86_64 for 64 bit operating systems and choose

i386 for 32 bit operating systems.
• Platform: The options depend on the Operating System you chose.

- Windows: Windows Server 2003, Windows Server 2008, and Windows Server 
2012.

- Linux: Centos, SUSE, Ubuntu, Debian, FreeBSD, CoreOS, Aliyun, Customized
Linux, and Others Linux (open a ticket to confirm the selected edition is
supported).

- If your image OS is a custom edition developed from Linux kernel, open a 
ticket to contact us.

• Image Format: Supports qcow2, RAW, and VHD. Qcow2 or VHD is
recommended.

• Image Description: Enter a description of the custom image.
• Add Images of Data Disks: Choose this option if you want to import an image

that contains data disks. Supported data disk capacity ranges from 5 GiB to 2,000
GiB.

9. Click OK.
10.(Optional) You can view the task progress in the image list of the import region.

Before the task is completed, you can find the imported custom image through 
Tasks management, and, if needed, cancel the import task.

You can also use the ECS API #unique_86 to import a custom image.
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Next step
Create an instance from a custom image.

References
• Custom images FAQ
• Create and import on-premise images by using Packer

5.4 Copy custom images
This topic describes how to copy a custom image that is under your Alibaba Cloud
account. This action enables you to create identical ECS instances across regions,
allowing you to implement seamless data backups of the target instances.

Background information
An image is a regional resource, and a custom image belongs to the region where it is
created. The following table lists the different scenarios of using custom images.
Scenario Procedure Description
Copy images 
across regions 
under the same 
account

See Copy images. When an image is copied, the correspond
ing snapshot is generated in the target 
region at the same time. After the copy 
operation is completed, a new image is 
generated in the target region, and it has a 
unique image ID.

Copy images 
across regions 
under different 
accounts

See Copy images and
Share images.

An image is copied to the target region and 
then shared with the target account.

Share images in 
the same region
 under different 
accounts

See Share images. This operation does not create a new image
. The shared image still belongs to you.

Limits
Before you copy a custom image, note the following:
• Only custom images can be copied across regions. If you need to copy an image of

 another type, you need to first use that image to create an instance and then use 
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that instance to create a custom image. Afterwards, you can copy the newly created
 custom image to the target region.

• When an image is copied, a corresponding snapshot is generated in the target
 region at the same time, and then a custom image is generated based on the 
snapshot. Therefore, data traffic occurs between the source and target regions. 
Currently, no fees are charged for this traffic. For the latest billing details, see the 
official Alibaba Cloud website for announcements.

• The created custom image in the target region has the same configuration as
the original custom image. However, the related role authorization and service
authorization information is not copied, nor are the settings of instance user data.

• The task completion time depends on the image size, the network transmission 
speed, and the number of concurrent tasks in the queue.

• Images with encrypted snapshots cannot be copied across regions.
Procedure

1. Log on to the ECS console.
2. In the left-side navigation pane, choose Instances & Images > Custom Images.
3. Select the custom image to be copied. Note that Type must be Custom Images.

Then, in the Actions column, click Copy Image.

Note:
If your custom image is larger than 500 GiB, when you click Copy Image, you will
be directed to open a ticket to complete the operation.

4. In the Copy Image dialog box, verify the ID of the selected image is the target
image, and then complete the following configurations:
a. Select the Target Region.
b. Enter Custom Image Name and Custom Image Description that are shown in the

target region.
c. Click OK.

5. (Optional) Switch to the target region and check the progress. When 100% is
displayed, the image is copied successfully.

Note:
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If Progress is not 100%, Status is Creating. In this case, you can click Cancel Copy
to cancel the operation. After the operation is canceled, the image information is
removed from the target region.

You can also call the ECS APIs CopyImage and CancelCopyImage to perform the
preceding operations.

What to do next
When a copied image is in the Available status, you can use it to create an instance or
change the system disk.
You can also view the copied snapshot in the target region.

5.5 Share images
After creating a custom image, you can share it with other Alibaba Cloud users.
Shared images help new users adapt to ECS faster as they can quickly create ECS
instances and set up business environments based on your custom images. Moreover,
shared images do not consume the image quota of the account from which an image is
shared.

Attention
You can only share custom images you have created, not custom images created and
 shared by other users. Each custom image can be shared with up to 50 users within 
the same Alibaba Cloud region. That is, an image cannot be shared across regions.
Before sharing an image, make sure that all sensitive data and files have been deleted
from the image.

Note:
The integrity or security of shared images is not guaranteed. Make sure that you
use only images shared by trusted accounts before using shared images. Besides,
you shall bear the risk on your own. After you create an instance based on a shared
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image, be sure to connect the instance to check the integrity and security of the
image.

Sharing image restrictions
If your custom image has been shared with other accounts, you must remove all the 
sharing relationships for that image before you can delete the image. After deleting a 
shared custom image:
• Users who are using the shared image will no longer be able to find the image 

through the ECS console or ECS API, nor can they use the image to create ECS 
instances or replace system disks.

• ECS instances that are created from the shared image cannot re-initialize their 
system disks.

Share an image
To share an image in the ECS console, follow these steps:
1. Log on to the ECS console.
2. Select the target region.
3. In the left-side navigation pane, choose Snapshots and Images > Images.
4. Select the target Custom Image the, in the Actions column, click Share Image.
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5. In the pop-up dialog box, select Alibaba Cloud Account ID in the Account Type
drop-down list. Then, enter the account ID that you want to share the image with in
the Account box. For more information, see Appendix:How to get the account ID?.

Note:
If you want to stop sharing the image with an account, click Unshare next to the
account. After you cancel the sharing, that account will be unable to query and
use the image. This means that i that account has already created an instance by
using this shared image, the instance will be unable to re-initialize the system
disk.

6. (Optional) For the accounts with whom you share an image, these account can view
the shared image in Snapshots and Images > Images > Share Image in the same
region in the ECS console.

You can also use the ECS APIs ModifyImageSharePermission and
DescribeImageSharePermission to share an image.

Next steps
After an image is shared with other users, they can use it to create one or more
instances.
1. Log on to the ECS console.
2. Create one or more instances by referring to Step 2. Create an instanceCreate

an instance in Quick Start. Note that you should select Shared Image during the
procedure.

They can also use the shared image to #unique_46 for instances.
Appendix: How to get the account ID?

To find your account ID, follow these steps:
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1. Log on to the ECS console.
2. Hover your mouse over your avatar and then click Security Settings from the

account menu.
3. On the page that appears, the account ID is displayed at the right as follows.

5.6 Export custom images
You can export custom images for on-premises testing or for Apsara stack
environments.

Note:
• The time it takes to export an image depends on the size of the image file and the 

number of export tasks in the queue.
• Exported images are stored in your OSS bucket. This means you are billed for the

OSS storage and download traffic. For more information, see OSSbilling items.
Limitations

Currently, the image export function has the following limitations:
• You cannot export custom images that are created by a system disk snapshot from

the Alibaba Cloud Marketplace.
• You can export the custom images that contain four snapshots of data disks at most

, and for a single data disk, the maximum volume must be no greater than 500 GiB.
• When using exported custom images to create an instance by using the wizard,

you must confirm that the file device recorded in /etc/fstab corresponds to the
exported data disk snapshot information.

Prerequisites
Before exporting a custom image, you must:
• Open a ticket  to activate the image export feature, and describe the use cases of

the exported images in the ticket.
• Activate OSS and make sure that the region where your custom images are located

has an available OSS bucket. For more information, seecreate a bucket.
Procedure

To export a custom image in the ECS console, follow these steps:
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1. Log on to the ECS console.
2. In the left-side navigation pane, choose Snapshot & Images > Images.
3. Select the target region.
4. Find the custom image you want to export and then, in the Actions column, click

Export Image.
a. In the Export Image dialog box, clickConform Address.
b. In the Cloud Resource Access Authorization window, click Confirm

Authorization Policy to allow ECS to access your OSS resources.
5. Return to the ECS console homepage. In the Actions column of the Images page,

click Export Image again.
6. In the Export Image dialog box:

• Select the OSS bucket in the specified region.
• Set the prefix of the object name of the exported image. For example, if you set 

Demo as the prefix, then the exported image file displayed in the OSS bucket is 
named Demo-[automatically generated file name].

7. Click OK.
8. (Optional) Cancel the image export task. Before the task is completed, you can

go to the Tasksmanagement page in the ECS console, find the relevant task in the
specified region and cancel the task.

You can also use the ECS APIs ExportImage and CancelTask to perform the preceding
operations.

Next steps
When an exported custom image contains a data disk snapshot, multiple files appear
in your OSS. The file name with system  indicates a system disk shapshot and the
file name with data  indicates a data disk snapshot. A data disk snapshot has an
identifier corresponding to the data disk, which is the mount point of the data disk,
such as xvdb or xvdc.
1. Log on to the OSS console to query the export result.
2. After the custom image is exported successful, download the object and then

download the custom image file.

Note:
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The format of the image file is RAW by default. However, the .tar.gz format is also
available during the gated launch period, and the file is in the .raw format after
you unzip the .tar.gz file. If you are using Mac OS X operating system, the agent
gnu-tar is recommended to unzip the file.

5.7 Delete custom images
This topic describes how to delete a custom image. You can delete a custom image if
you no longer need it. Deleting a custom image does not impact the instances created
from the image or images copied from this image. Similarly, deleting image copies of
a custom image has no impact on this custom image.

Limits
• After a custom image is deleted, it cannot be used to create new ECS instances

. However, ECS instances created from the deleted custom image can still run 
normally (that is, continue to incur fees), but these instances cannot reinitialize 
their cloud disks.

• If the to be deleted custom image has been shared to other accounts, you must
remove all permissions that allow shared access to the custom image before you
can delete the image. After a shared image is deleted:
- Users who are using the shared image will no longer be able to find the image 

through the ECS console or ECS API, nor can they use the image to create ECS 
instances or replace cloud disks.

- ECS instances that are created from the shared image cannot reinitialize their 
cloud disks.

Procedure
1. Log on to the ECS console.
2. In the left-side navigation pane, choose Instances & Images > Custom Images.
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3. On the Images tab page, select the image you want to delete. Note that the image
type must be Custom Images.

4. Click Delete Image.
5. In the displayed dialog box, select the deletion method.

• Delete: Delete a custom image by following the general procedures.
• Force Delete: Forcibly delete a customer image. Select this option if you have

created ECS instances by using this image.

Notice:
After a custom image is forcibly deleted, instances created by using this image
cannot reinitialize their cloud disks.

6. Click OK.
You can also call DeleteImage to delete a custom image.
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6 Marketplace images
An Alibaba Cloud Marketplace image is equivalent to the installation disk for
an Elastic Compute Service (ECS) instance. A Marketplace image allows you to
quickly obtain a running environment for ECS instances and any pre-installed
software applications. Such an image can be used for site deployment, application
development, and visualized management. Marketplace images effectively allow ECS
instances to be used out-of-the-box, helping to reduce costs.

Select a Marketplace image when creating an instance
We recommend that you use a Marketplace image if you are new to working with ECS 
instances. To deploy a Marketplace image, follow these steps:
1. Go to the ECS purchase page.
2. Select and configure your image. For more information, see create an Instance.

Then, on the Image configuration page, choose Marketplace Image > Select from
image market (including operating system).

Purchase an image from Alibaba Cloud Marketplace and create an instance
1. Go to Alibaba Cloud Marketplace.
2. Select the required image and click Buy Now.
3. You may be required to log on to the Alibaba Cloud console before proceeding.

4. Select and configure your image. For more information, see create an instance.
Change the operating system by using the Marketplace image

If you have purchased ECS instances, use an image to deploy the running environmen
t or install software applications as follows:

Note:
If you change the image, the data on the system disk will be lost. Therefore, we
recommend that you back up your data before changing your operating system. For
more information, see Create snapshots.

1. Log on to the ECS console.
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2. Stop the target instance.
3. On the Replace System Disk page, select Marketplace Image in the Image Type

setting. For more information, see replace the system disk (non-public image).
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7 Open source tools
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8 Change the operating system
You can convert the OS running on your ECS instance to another supported OS
through the ECS console.
To change the operating system, you must change the system disk of an instance:
• If you want to use a custom image, see change the system disk (custom image).
• If you want to use a public image, see change a system disk (public image).

Note:
Currently, instances that are hosted in regions outside of mainland China do not
support swapping between Linux and Windows OSs. If your instance is hosted in one
of these regions, you can only change its version of Windows OS to another version of
Windows, or replace its current Linux OS with another Linux OS.
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9 FAQ
9.1 Image FAQ
What differences are there between Aliyun Linux 2 and Aliyun Linux?

Aliyun Linux 2 differs from Aliyun Linux in the following aspects:
• Aliyun Linux 2 is optimized for containers to better support cloud-native applicatio

ns.
• Aliyun Linux 2 is equipped with an updated Linux kernel mode and updated user 

mode packages.
How do I use Aliyun Linux 2 in Alibaba Cloud?

Alibaba Cloud provides an official public image for Aliyun Linux 2. You can select this
 image when you create an ECS instance.

Am I charged for the use of Aliyun Linux 2 in Alibaba Cloud ECS?
No, the Aliyun Linux 2 image is free to use. You are only charged for the usage of the 
corresponding ECS instance to which the image is applied.

Which ECS instance types does Aliyun Linux 2 support?
Aliyun Linux 2 supports most ECS instance types, including ECS Bare Metal Instance.

Note:
Aliyun Linux 2 cannot be applied to instances that use the Xen virtual machine
platform or a classic network, and will not be displayed as an image option.

Does Aliyun Linux 2 support 32-bit applications and databases?
No. Currently, Aliyun Linux 2 does not support 32-bit applications or databases.

Does Aliyun Linux 2 provide a GUI desktop?
No. Currently, Aliyun Linux 2 does not provide a GUI desktop.

Can I view the source code of Aliyun Linux 2 components?
Yes. Aliyun Linux 2 complies with open source protocols. You can use the 
yumdownloader tool or visit official Alibaba Cloud download pages to download the 

Issue: 20190718 101



Elastic Compute Service Images /  9 FAQ

source code package. You can also download the source code tree of the Aliyun Linux 
kernel from Github.

Is Aliyun Linux 2 backward-compatible with the current Aliyun Linux version?
Yes. Aliyun Linux 2 is fully compatible with Aliyun Linux 17.01.

Note:
If you use a kernel module that you compiled, you may need to re-compile it on
Aliyun Linux 2 before you can use it.

Can I use Aliyun Linux 2 locally?
No. Currently, Aliyun Linux 2 only supports Alibaba Cloud ECS. Third-party virtualize
d platforms are not supported.

Which third-party applications can run on Aliyun Linux 2?
Currently, Aliyun Linux 2 is binary-code compatible with CentOS 7.6.1810. Therefore, 
applications that can run on CentOS can also run on Aliyun Linux 2.

What are the advantages of Aliyun Linux 2 when compared with other Linux operating systems?
Compared with CentOS and RHEL, Aliyun Linux 2 has the following advantages:
• Updates are released at a faster, and provide more advanced Linux kernels, user 

mode software, and toolkit
• No configuration required, out-of-the-box functionality
• Zero run-time billing (compared with RHEL) and provided with commercial 

support (compared with CentOS)
What data protection functions are included with Aliyun Linux 2?

Aliyun Linux 2 protects your data by using the following methods:
• It uses industry standard vulnerability scanning and security test tools to conduct 

periodical security scanning.
• It periodically accesses the CVE patch of CentOS 7 to fix OS security vulnerabilities.
• It supports existing OS security solutions of Alibaba Cloud.
• It uses the same mechanism as CentOS 7 to release user security alerts and patch 

updates.

Note:
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Aliyun Linux 2 is binary-code compatible with CentOS 7.6.1810 and RHEL 7.6, and is
security compliant with the RHEL safety specifications.

Does Aliyun Linux 2 support data encryption?
Yes. Aliyun Linux 2 retains the data encryption toolkit of CentOS 7 to support data 
encryption implemented by CentOS 7 and KMS.

How do I grant permissions to manage Aliyun Linux 2?
The method to grant permissions to manage Aliyun Linux 2 is the same as that of 
Alibaba Cloud CentOS 7. This means that an administrator of CentOS 7 can use the 
same management commands to grant permissions of Aliyun Linux 2.

Does the system disk of an ECS instance support KMS encryption, and can I use KMS encryption
through Terraform or Packer?

The system disk of an ECS instance supports KMS encryption by using the key that is
automatically generated by KMS. After you select KMS encryption, ECS automatically
creates a dedicated CMK in the region where KMS is used. For more information, see
#unique_115.
Support for Terraform is available, while support BYOK encryption and Packer 
encryption is in development.
In Terraform, you can set the encrypted  parameter to enable or disable KMS
encryption. For more information, see alicloud_disks.

9.2 Manage Windows Server Semi-Annual Channel images andinstances
This topic describes the various methods you can use to manage an Alibaba Cloud
ECS instance created from a Windows Server Semi-Annual Channel image.

Image overview
ECS now supports Windows Server Semi-Annual Channel images. When creating
an instance, you can find the Version 1809 Datacenter image in the list of Windows
Server public images. Windows Server Semi-Annual Channel images are operating
system images running in pure Server Core mode and do not provide a graphical
user interface. Windows Server Semi-Annual Channel images have much looser
requirements for hardware, thus reducing the update frequency and supporting
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remote management. Alibaba Cloud ECS currently supports the following Windows
Server Semi-Annual Channel versions:
• Windows Server 1809 Datacenter edition
• Windows Server 1709 Datacenter edition

Instance management tools
Instances that run Windows Server Semi-Annual Channel are not provided with
 the resource manager or control panel functions, or Windows Explorer, and do 
not support any .msc features (such as devmgmt.msc). However, you can manage
 Windows Server Semi-Annual Channel instances by using such tools as Sconfig, 
Server Manager, PowerShell, and Windows Admin Center.
Additionally, Windows Server Semi-Annual Channel instances run in Server Core
mode. In this case, we recommend that you use PowerShell and Windows Admin
Center to manage your instances. Procedures for the preceding management tools are
provided in the following sections For more information, see Manage a Server Core 
server.

PowerShell
In the following example, assume that the public IP address of your instance is
172.16.1XX.183. To implement PowerShell for remote management, follow these
steps:
1. Connect to the target instance. For more information, see Connect to a Windows

instance.
2. Enter PowerShell  in the command line of the target instance.
3. Run the following command in PowerShell:

Enable - PSRemoting  - Force
Set - NetFirewal lRule  - Name  " WINRM - HTTP - In - TCP - PUBLIC
" - RemoteAddr ess  Any

4. Add a rule to the security group of the target instance to allow access to the HTTP
port 5985 and the HTTPS port 5986. For more information, see Add security group
rules.

5. Enter PowerShell  in the command line of your client.
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6. Run the following command in PowerShell:
Set - Item  WSMan : localhost \ client \ trustedhos ts  - value  
172 . 16 . 1XX . 183  - Force

Note:
172.16.1XX.183 indicates that only your instance is trusted. You can also use * to
indicate that all computers are trusted.

7. Run Enter - PSSession  ' 172 . 16 . 1XX . 183 ' - Credential :'

administra tor ' in PowerShell and enter the instance password as prompted.
Now you can manage your Windows instance on your client computer.

Windows Admin Center
In the following examples, assume that the public IP address of your instance is 172.
16.1XX.183. You can install Windows Admin Center either by using the command line 
or by downloading the installation package from the official website.
• Install Windows Admin Center through the command line

1. Connect to the target instance. For more information, see Connect to a Windows
instance.

2. Add a rule to the security group of the target instance to allow access to the
HTTP 5985 and the HTTPS port 5986. For more information, see Add security
group rules.

3. Enter PowerShell  in the command line of the target instance.
4. Run the following command in PowerShell:

Enable - PSRemoting  - Force
Set - NetFirewal lRule  - Name  " WINRM - HTTP - In - TCP -
PUBLIC " - RemoteAddr ess  Any

5. Run the following command to download Windows Admin Center.
wget  - Uri  http :// download . microsoft . com / download
/ E / 8 / A / E8A26016 - 25A4 - 49EE - 8200 - E4BCBF292C 4A /
HonoluluTe chnicalPre view1802 . msi  - UseBasicPa rsing  -
OutFile  c :\ HonoluluTe chnicalPre view1802 . msi
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msiexec  / i  c :\ HonoluluTe chnicalPre view1802 . msi  / qn

 / L * v  log . txt  SME_PORT = 443  SSL_CERTIF ICATE_OPTI ON
= generate

6. Run the cat  log . txt  command to check the download progress. When
the following information appears in the log file, Windows Admin Center is
installed.
MSI  ( s ) ( 14 : 44 ) [ 09 : 48 : 37 : 885 ]: Product : 
Project  ' Honolulu '( technical  preview ) -- Installati on  
completed  successful ly . 
MSI  ( s ) ( 14 : 44 ) [ 09 : 48 : 37 : 885 ]: Windows  
Installer  has  installed  this  product . Product  name : 
Project  ' Honolulu '( technical  preview ). Product  version
: 1 . 1 . 10326 . 0 . Language : 1033 . Producer : Microsoft
 Corporatio n . Installati on  success  or  error  status
: 0 .

• Download and install Windows Admin Center through a browser
Prerequisites
Make sure that you are using a browser in the target client where Windows Admin
Center is to be downloaded. PowerShell is configured. For more information, see
PowerShell remote management.
Procedure
1. Download and install Windows Admin Center.
2. Open https://localhost/.
3. Click Add to add the instance IP address in the displayed window.
Now you can manage your instance through Microsoft Edge or Chrome from the 
client computer of Windows Admin Center.

FAQ
How do I copy files to a Windows Server Semi-Annual Channel instance?
You can use RDP applications, PowerShell, or the Windows Admin Center to copy files
from a client to a Windows Server Semi-Annual Channel instance.
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• Through RDP applications
1. Connect to the target instance. For more information, see Connect to a Windows

instance.
2. On the client, copy the target files.
3. In the CMD utility of your instance, enter notepad .
4. Click File > Open. In the displayed window, select the destination directory for

the files, then right-click and choose Paste.
• Through PowerShell

1. Start the target instance.
2. Open the CMD utility on the client, and enter PowerShell .
3. Access the target instance remotely through PowerShell. For more information,

see PowerShell remote management.
4. Run the following command on the client:

$ session  = New - PSSession  - ComputerNa me  172 . 16 . 1XX .
183
Copy - Item  - ToSession  $ session  - Path  C :\ 1 . txt  -
Destinatio n  c :\ 2 . txt

Note:
C :\ 1 . txt  is the source file directory on the client computer, while C :\

2 . txt  is the target file directory on the Windows instance.
• Through Windows Admin Center

1. Start the target instance.
2. Configure Windows Admin Center. For more information, see Windows Admin

Center.
3. Open Windows Admin Center, and click the managed instance.
4. Click File, select the target files and then click Upload.

How do I shut down or restart a Windows Server Semi-Annual Channel instance in the
 instance itself?
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• Through RDP applications
1. Connect to the target instance. For more information, see Connect to a Windows

instance.
2. In the CMD utility, enter sconfig . Then, enter 13  to restart your instance or 

14  to shut it down, and press Enter.
• Through PowerShell

1. Connect to the target instance. For more information, see Connect to a Windows
instance.

2. In the CMD utility, enter PowerShell .
3. Enter one of the following commands to restart or shut down your instance:

shutdown  - r  - t  00  :: # Restart  your  instance  in  0
 seconds  through  the  command - line  command
shutdown  - s  - t  00  :: # Shut  down  your  instance  in
 0  seconds  through  the  command - line  command
Stop - Computer  - Force  # Shut  down  your  instance  
immediatel y  through  the  Powershell  command
Restart - Computer  - Force  # Restart  your  instance  
immediatel y  through  the  Powershell  command

• Through PowerShell remote management
1. Start the target instance.
2. Open the CMD utility on the client, and enter PowerShell .
3. Access the target instance remotely through PowerShell. For more information,

see PowerShell remote management.
4. Enter one of the following commands on the client:

Enter - PsSession  – ComputerNa me  172 . 16 . 1XX . 183
Restart - Computer  - Force  # Restart
Stop - Computer  - Force  # Shut  down

• Through Windows Admin Center
1. Start the target instance.
2. Configure Windows Admin Center. For more information, see Windows Admin

Center.
3. Open Windows Admin Center, and click the managed instance. Then, click

Overview, and select Restart or Shut down.
How do I install the IIS service?
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• Through RDP applications
1. Connect to the target instance. For more information, see Connect to a Windows

instance.
2. In the CMD utility, enter PowerShell .
3. Run the following command to install IIS:

Import - Module  ServerMana ger
Add - WindowsFea ture  Web - Server , Web - CGI , Web - Mgmt
- Console

• Through PowerShell remote management
1. Start the target instance.
2. Open the CMD utility on the client, and enter PowerShell .
3. Access the target instance remotely through PowerShell. For more information,

see PowerShell remote management.
4. Run the following command on the client:

Enter - PsSession  – ComputerNa me  172 . 16 . 1XX . 183
Import - Module  ServerMana ger
Add - WindowsFea ture  Web - Server , Web - CGI , Web - Mgmt
- Console

• Through Windows Admin Center
1. Start the target instance.
2. Configure Windows Admin Center. For more information, see Windows Admin

Center.
3. Open Windows Admin Center, and click the managed instance. Click Roles and

Features and Web Server in sequence, select the desired function, and click Yes.
How do I re-open a command line window that was accidentally closed in an RDP 
session?
To re-open a command line window, follow these steps:
1. Press Ctrl + Alt + End. If the preceding combination does not work, press Ctrl + Alt

 + Del.
2. In the interface that appears, select Task Manager and press Enter.
3. Click File > New Task, enter cmd , and click OK.

References
• Windows Server Semi-Annual Channel overview.
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• Introducing Windows Server, version 1709
• Windows Admin Center
• About Remote Troubleshooting

9.3 Install GRUB v1.99 in a Linux server
This topic describes how to install GRand Unified Bootloader (GRUB) in a Linux
server by using GRUB v1.99 as an example. To install GRUB of a later version, you
need to download the relevant GRUB package.

Background information
When you migrate a source Linux server by using the Cloud Migration tool, if the
source Linux server has a low kernel version (such as CentOS 5 and Debian 7), and
the version of the built-in system boot program GRUB is lower than v1.99, the log file
indicates Do  Grub  Failed . In this case, you need to upgrade GRUB to v1.99 or
later.

Procedure
1. Log on to the source Linux server.
2. Run the following commands to view the directories of the original grub , grub

- install , and grub - mkconfig :
# which  grub
# which  grub - install
# which  grub - mkconfig

3. Run the mv  command to rename the original grub , grub - install , and 
grub - mkconfig  files for backup.

Note:
After you migrate your server by using the Cloud Migration tool, you can reinstate
the original files by changing their names back to the original ones.
# mv  / sbin / grub  / sbin / grub - old
# mv  / sbin / grub - install  / sbin / grub - install - old  
# mv  / sbin / grub - mkconfig  / sbin / grub - mkconfig - old

4. Run the yum  install  - y  bison  gcc  make  command to install the
dependencies of GRUB, which include bison, gcc, and make.

5. Run the following commands to install flex.
# test  - d  / root / tools  || mkdir  - p  / root / tools
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# cd  / root / tools
# wget  https :// github . com / westes / flex / releases /
download / v2 . 6 . 4 / flex - 2 . 6 . 4 . tar . gz
# tar  xzf  flex - 2 . 6 . 4 . tar . gz
# cd  flex - 2 . 6 . 4
# mkdir  - p  build
# cd  build
# ../ configure
# make  && make  install
# ln  - s  / usr / local / bin / flex  / usr / bin / flex

6. Run the following commands to install the dependencies of GRUB v1.99.
# test  - d  / root / tools  || mkdir  - p  / root / tools
# cd  / root / tools
# wget  https :// alpha . gnu . org / gnu / grub / grub - 1 . 99 ~
rc1 . tar . gz
# tar  xzf  grub - 1 . 99 ~ rc1 . tar . gz
# cd  grub - 1 . 99 ~ rc1
# mkdir  - p  build
# cd  build
# ../ configure
# sed  - i  - e  " s /- Werror //" ./ grub - core / Makefile
# sed  - i  - e  " s /- Werror //" ./ Makefile
# make  && make  install
# ln  - s  / usr / local / sbin / grub - install  / sbin / grub -
install
# ln  - s  / usr / local / sbin / grub - mkconfig  / sbin / grub -
mkconfig

Note:
If the error - Werror  occurs, we recommend that you locate the error in the 
makefile , remove the - Werror  option, and then try again.

7. Run the grub - install  -- version  command to verify GRUB is updated to
v1.99.

What to do next
1. After you update GRUB to v1.99, you can migrate your server to Alibaba Cloud by

using the Cloud Migration tool.
2. (Optional) After your servers are successfully migrated to Alibaba Cloud, run the

following commands to use the earlier version of GRUB.
# rm  / sbin / grub - install
# rm  / sbin / grub - mkconfig
# rm  / boot / grub / grub . cfg
# mv  / sbin / grub - old  / sbin / grub
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# mv  / sbin / grub - install - old  / sbin / grub - install

9.4 How do I enable or disable the Meltdown and Spectrepatches for Linux images?
This topic describes how Alibaba Cloud ECS responds to the Meltdown and Spectre
vulnerabilities. You can learn about our measures for protecting ECS instances
against these vulnerabilities.

Context
The Meltdown and Spectre vulnerabilities exist in the Intel chips. Caused by the 
design flaw of the chip hardware, the vulnerabilities may lead to problems such as
 leakage of operating system kernel information, unauthorized access to system 
kernel data by applications, and more. You can go to the CVE website to check the 
vulnerability IDs:
• CVE-2017-5753
• CVE-2017-5715
• CVE-2017-5754
On January 20, 2018, Alibaba Cloud released a security vulnerability notice,
describing the vulnerability details and impacts.
This topic describes the Alibaba Cloud public images that have been patched against 
these vulnerabilities, and how to disable the patches for better instance performance
. The default security policy is as follows:
• To protect against the Meltdown vulnerability, Page Table Isolation (PTI) is enabled

 by default.
• To protect against the Spectre vulnerability, by default No Indirect Branch 

Restricted Speculation (NOIBRS) is enabled and is integrated with Retpoline and 
Indirect Branch Prediction Barriers (IBPB).

How to enable or disable the Meltdown patch
The following public images have enabled the Meltdown patch (PTI On):
• CentOS 7.5/7.6
• Debian 9.6/8.10
• Red Hat 7.5/7.6
• SUSE Linux 15
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• Ubuntu 18.04
• CoreOS 1911.3.0
• FreeBSD 11.2
• OpenSUSE 15
The above list is subject to change due to updates of Alibaba Cloud public images.
If you find enabling PTI impacts your instance performance, or you have other 
protective measures, you can disable PTI by following the steps below:
1. Connect to your instance.
2. Do the following according to your Linux distribution:

• CentOS, Debian, OpenSUSE, Red Hat, SUSE Linux and Ubuntu: Add the kernel
parameter nopti .

• CoreOS: Run vi  / usr / share / oem / grub . cfg  to configure pti =

off .
• FreeBSD: Run vi  / boot / loader . conf  to configure vm . pmap . pti

= 0 .
3. Restart the instance.

How to enable or disable the Spectre patch
Alibaba Cloud currently allows you to configure Indirect Branch Restricted Speculatio
n (IBRS) and IBPB. By default, public images are protected against Spectre through 
Reptpoline and IBPB. Moreover, IBRS is disabled through the noibrs parameter. The 
following public images are involved:
• CentOS 7.5/7.6
• Debian 9.6/8.10
• Red Hat 7.5/7.6
• SUSE Linux 15
• Ubuntu 18.04
• CoreOS 1911.3.0
• FreeBSD 11.2
• OpenSUSE 15
The above list is subject to change due to updates of Alibaba Cloud public images.
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If you need to restore the default settings of your operating system, or you find the
 current settings impact your instance performance, or you have other protective 
measures, you can disable the Spectre patch by following the steps below:
1. Connect to your instance.
2. Perform the corresponding operation according to the instructions in the

following table.
Linux 
distributi
on

To restore the default
 settings of Alibaba 
Cloud images

To restore the default
 settings of operating 
systems

To disable the 
Spectre patch

CentOS
Red Hat

Add the kernel 
parameter noibrs.

Remove the kernel 
parameter noibrs.

CoreOS Run vi  / usr /
oem / share / grub
. cfg  to add the

kernel parameter
spectre_v2=off.

OpenSUSE Add the kernel 
parameter spectre_v2=
off.

Remove the kernel 
parameter spectre_v2=
off.

Debian
Ubuntu

Retpoline and IBPB are 
enabled by default.

SUSE 
Linux

Retpoline is enabled by
 default.

No need to modify the 
settings.

Add the kernel
 parameter 
spectre_v2=off.

FreeBSD Add the kernel
 parameter hw.
ibrs_disable.

Remove the kernel
 parameter hw.
ibrs_disable.

Add the kernel
 parameter hw.
ibrs_disable.

Note:
The kernel parameter noibrs  does not work for OpenSUSE and CoreOS. You
need to set spectre_v2 = off  for them.

3. Restart the instance.
How to detect whether protections are enabled

1. Connect to your instance.
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2. From GitHub spectre-meltdown-checker Repo, obtain the spectre-meltdown-
checker.sh script.

3. Run the following commands in your instance:
chmod  + x  spectre - meltdown - checker . sh
sudo  bash  spectre - meltdown - checker . sh

4. Judge whether the Meltdown or Spectre patch has been enabled according to the 
script prompts.

Reference
For the following operating systems, you can go to their website for more details:
• Red Hat
• SUSE Linux
• Ubuntu
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